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Chapter 1: Introduction

Welcome to the EditShare Version 6.0 Editor's Guide. This document introduces you to the 
purpose and functions of your EditShare system, explains the concepts you’ll need to 
understand to use it effectively, and describes workflow procedures. The Editor's Guide is 
designed not only for editors but also administrators, technical support specialists, and anyone 
else who uses the EditShare system.

The manual begins by providing a high-level overview of what EditShare is and how you use 
it to store and share media files and metadata. It provides specific instructions for connecting 
to EditShare on Windows and Macintosh computers, explains the concept of Media Spaces 
and how EditShare facilitates sharing media, discusses the other Spaces EditShare provides, 
and presents instructions for sharing files. Information specifically for users of individual 
non-linear editing applications (NLEs) is also included, as well as a comprehensive Index.

See the following topics:

• Additional Documentation

• Technical Support

• Chapter 2: Overview

• Chapter 3: Getting Started as an Editor

• Chapter 4: Media Spaces

• Chapter 5: Metadata Spaces

• Chapter 6: Acting as a Limited Administrator

• Chapter 7: Using EditShare with Avid

• Chapter 8: Using EditShare with Final Cut Pro

• Chapter 9: Using EditShare with Premiere Pro

• Chapter 10: Using EditShare with Other NLEs

• Appendix A: Communicating with Jabber Instant Messenger

• Appendix B: Traditional Media Spaces

Additional Documentation

The following documents are also available from EditShare:
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• EditShare Administrator’s Guide

• EditShare QuickStart Network Configuration Guide

In addition, the following specialized guide is available for customers who 
purchase optional features:

• EditShare Guide to iSCSI Option

• EditShare Ark Setup and User’s Guide

• EditShare Flow Setup and User’s Guide

Finally, you might also want to read guides specific to third-party software such 
as the Avid editing applications or Apple Final Cut Pro.

Technical Support

For questions not addressed in our documentation, contact EditShare 
Technical Support at support@editshare.com. Have the exact version number 
of your EditShare implementation ready.



Chapter 2: Overview

This chapter introduces you to the high-level concepts you need to understand in order to use 
EditShare.

See the following topics:

• What is EditShare?

• EditShare Administrator

• EditShare Workflows

• Metadata and Media Files

What is EditShare?

Your EditShare system is a Network Attached Storage (NAS) server or group of servers with 
hardware and software that are highly optimized for video editing. It provides a networked file 
system for both media files and metadata that enables multiple editors to collaborate on 
projects. Editors can work with the same media files, bins, and sequences in a controlled 
fashion that limits the opportunities for editors to accidentally or maliciously interfere with 
each others' work.

See the following topics:

• "EditShare Hardware" on page 11

• "EditShare Spaces" on page 12

EditShare Hardware

The EditShare system is a high-performance, high-bandwidth, powerful storage system. Its 
complexity is hidden from the editors and other people using the system, such complexity is 
hidden. You simply see a group of remote drives that appear to your systems just like other 
local hard drives built into your computer or connected via FireWire. A simple utility, 
EditShare Connect, allows you to connect to the drives you need and perform sharing 
operations.
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EditShare Spaces

The purpose of EditShare is to make available Spaces in which you can store 
data. You can access these Spaces almost as if they were physical hard drives 
connected to your computer, even though they are actually located on a storage 
array on the EditShare server and are accessed over your network. These kinds 
of network Spaces are referred to by a variety of names. For example, you might 
see them referred to as drives, shares, folders, volumes, or directories, possibly 
preceded by “network” or “remote.” They all mean essentially the same thing: 
places on the network where you can store data.

Once you have logged in to EditShare (as described in "Logging in with 
EditShare Connect" on page 25), you see the Spaces available to you in EditShare 
Connect as well as in Windows Explorer or the Macintosh Finder. You can 
access several types of Spaces, each with its own purpose. (Most organizations 
use only a few types of Spaces, not all of them.)

Type of Space
Space 

Subtype Description
For more 

information

Media Space Stores media files. Different types of Media Spaces use different 
strategies to manage the way NLE systems can access the data 
and to protect media from accidental modification or deletion 
as shown below. Access to each Media Space is restricted to 
specified users.

See "Chapter 4: 
Media Spaces" on 
page 37.

AvidMXF For Avid editing applications only. Each editor owns one or 
more folders into which to capture or render media. The media 
in each editor's folders is read-only to other editors. Each 
editor can modify or delete the files in his or her own folders, 
but not in another user's folders. The Administrator can 
Protect files to make them undeletable, even by the original 
creator. Maintenance Mode allows one user to organize or 
delete any files.

See "AvidMXF 
Media Spaces" on 
page 39.

Managed For all NLEs except Avid. Editors can modify or delete their 
own files, but not another user's files. The Administrator can 
Protect files to make them undeletable even by the original 
creator, or Unprotect files to allow one user to organize or 
delete all files. Maintenance Mode allows one user to organize 
or delete any files.

See "Managed 
Media Spaces" on 
page 48.
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Traditional NOTE:  EditShare recommends against using this type of Space 
and you can no longer create a new non-Avid Traditional Space. 
It is better to use AvidMXF or Managed Spaces.

Different versions for each NLE. Editors can modify or delete 
their own files until they Share them. Unshared files cannot be 
seen by other editors. Editors must Refresh to see newly Shared 
files and Unshare to a specified user to allow that user to 
organize or delete files. For Avid Media Spaces, each user has 
his or her own media database for each Media Space.

See "Appendix B: 
Traditional Media 
Spaces" on page 
141.

Unmanaged Any editor can modify or delete any file. No protection is 
provided against accidental or malicious modification or 
deletion.

See "Unmanaged 
Media Spaces" on 
page 53.

Private Files 
Space

Small private Space for each user to store project files. Media 
not permitted.

See "Private Files 
Spaces" on page 55.

File Exchange 
Space

Small shared Space for each user to store project files. Media 
not permitted.

See "File Exchange 
Spaces" on page 56.

Shared Project 
Space

Space to store shared projects. Media not permitted See "Sharing Avid 
Projects" on page 
92 and "Sharing 
Final Cut Pro 
Projects" on page 
120

Type of Space
Space 

Subtype Description
For more 

information
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EditShare Administrator

An EditShare Administrator must be designated. In some organizations this is 
a system administrator or technical support specialist who knows a little bit 
about video editing, while in others it is an editor who takes on this additional 
role. The EditShare Administrator has the following responsibilities:

• Set up and configure the EditShare server and network (or help the dealer 
to do so), following the detailed instructions in the EditShare 
Administrator’s Guide.

• Create user accounts on the EditShare system and provide editors with the 
usernames and passwords they are to use. (See chapters 6-8 of the 
EditShare Administrator’s Guide.) Some users might be granted limited 
administrative capabilities, for example, a lead editor on a particular 
project might be allowed to manage the media for that project.

• Create Media Spaces for storing media files, typically one or more Media 
Spaces for each project. (See chapters 10-12 of the EditShare 
Administrator’s Guide.) 

• Oversee management of media on the EditShare server by ensuring that 
media is protected when it should be and coordinating times when media 
is organized or deleted.

• Provide a first line of support for other editors in the organization, helping 
them to learn the EditShare system and attempting to resolve problems 
locally before calling your dealer or EditShare Technical Support.

EditShare Workflows

The following is a general overview of how you use the EditShare system to store 
media files and projects and share them among multiple editors. Different 
organizations naturally use slightly different workflows, so you might find that 
the system at your organization is not exactly like this, but it should be similar.

When you begin working, you run EditShare Connect on your workstation to 
log in to EditShare, being careful that no one else is logged in at the same time 
with the same username. This gives you access to all the Spaces described in the 
previous section. (See "Chapter 4: Media Spaces" on page 37 for more detailed 
information about how to use these Spaces.) You mount the Spaces you intend 
to work with (on the desktop, for Macintosh; mapping them to drive letters, in 
Windows), and start your NLE.
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See the following topics:

• "Avid Editors – Shared Projects Workflow" on page 15

• "Final Cut Pro and Premiere Editors – Shared Projects Workflow" on page 
15

• "Final Cut Pro, Premiere, and Other NLE Editors – Individual Projects 
Workflow" on page 16

• "Editors – Traditional Workflow" on page 17

Avid Editors – Shared Projects Workflow

As an Avid editor, you are very likely working with an Avid Shared Project. 
Once you have started EditShare Connect and mounted the Media and Project 
Spaces you intend to use, you can start Avid as usual (see "Chapter 3: Getting 
Started as an Editor" on page 21). In some situations, you might instead start 
Avid using the Avid Launcher on the Avid Management tab of EditShare 
Connect. See "Avid Launcher" on page 102 for more information about when 
and how to use the Avid Launcher.

When you’re ready to capture media, you tell Avid to store its captured media 
in an AvidMXF Media Space instead of on a local hard drive, and you log it into 
a bin in your personal folder in the project. Other users can see the clips you 
capture immediately and edit them into their sequences, but they cannot delete 
them – only you can do that. You can also look at the clips other users have 
captured, and the sequences they've cut, by looking in the bins in their user 
folders. To work on another user's sequence, you make a copy of the sequence 
in one of your own bins first – you cannot modify anything in another user's 
bin, just as no one else can modify anything in your bins.

The EditShare Administrator (or a designated user) might Protect the media 
you've captured, to guard against accidentally deleting it after other editors have 
cut it into their sequences. 

For detailed information, see "Project Sharing with Avid" on page 57 and 
"Chapter 7: Using EditShare with Avid" on page 75.

Final Cut Pro and Premiere Editors – Shared Projects Workflow

As a Final Cut Pro or Premiere editor, you are very likely working with a Final 
Cut Shared Project or a Premiere Shared Project. Once you have started 
EditShare Connect and mounted the Media and Project Spaces you intend to 
use, you can start your editing application as usual, along with the EditShare 
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Project Browser (see "Chapter 3: Getting Started as an Editor" on page 21). A 
Shared Project must be created by the EditShare Administrator.

When you’re ready to capture media, you create a new Final Cut Project file or 
Premiere Project file in the project structure in the Shared Project Space. You 
set Final Cut's Capture Scratch directory to a Managed Media Space instead of 
a folder on a local hard drive, and you log it into a bin in your own project file. 
Other users can open your project and see the clips you capture as soon as you 
save the project. They can edit your clips into their sequences, but they cannot 
modify or delete them – only you can do that. You can also look at the clips 
other users have captured, and the sequences they've cut, by looking in the 
project files stored in their user folders. To work on another user's sequence, 
you make a copy of the sequence in one of your own project files first, then edit 
it there – you cannot modify anything in another user's project file, just as no 
one else can modify anything in your project files.

The EditShare Administrator (or a designated user) might Protect the media 
you've captured, to guard against accidentally deleting it after other editors have 
cut it into their sequences. 

For more information, see "Project Sharing with Final Cut Pro, Premiere Pro, 
and Other NLEs" on page 59 and "Chapter 8: Using EditShare with Final Cut 
Pro" on page 117.

Final Cut Pro, Premiere, and Other NLE Editors – Individual 
Projects Workflow

As an editor using Final Cut Pro to work on a standalone project, or if you use 
another NLE system such as Adobe Premiere, you keep your own copy of the 
project on your hard drive or in your Private Files Space on the EditShare server. 

When you’re ready to capture media, you tell your NLE to store its captured 
media in a Managed Media Space instead of on a local hard drive. You can 
rename, move, modify, or delete the files you captured, but no one else can. 
Other users can see your captured media immediately and import it into their 
project – or, to help keep media organized, you might export a copy of the bin 
you captured into and save it in the Shared Project Files folder on the EditShare 
server for other users to import. They can then incorporate the captured media 
into their sequences. 

The EditShare Administrator (or a designated user) might Protect the media 
you've captured, to guard against accidentally deleting it after other editors have 
cut it into their sequences.
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For more information, see "Chapter 8: Using EditShare with Final Cut Pro" on 
page 117, "Chapter 9: Using EditShare with Premiere Pro" on page 131, and 
"Chapter 10: Using EditShare with Other NLEs" on page 135.

Editors – Traditional Workflow

The Traditional Share-and-Refresh workflow is still available for users 
accustomed to older versions of EditShare and for Avid users who must work 
with OMF media. However, there are few if any other reasons to use Traditional 
Media Spaces. If you are working with EditShare for the first time, or beginning 
a new project, you probably would do better to use the simpler workflows 
enabled by AvidMXF and Managed Media Spaces.

For more information, see "Appendix B: Traditional Media Spaces" on page 141.

Metadata and Media Files

Non-linear editing projects include two types of files: media files and metadata 
files. In order to use EditShare safely and effectively, you need to understand the 
differences between them. These differences require you to use somewhat 
different strategies for sharing them.

See the following topics:

• "Media Files" on page 17

• "Metadata Files" on page 18

• "Other Files" on page 18

• "Why Sharing Metadata is Different from Sharing Media Files" on page 18

Media Files

Media files are your captured or rendered video and audio files. The essential 
fact about media files is that, once they have been captured, they are ordinarily 
not modified. When you edit with an NLE, the software does not modify 
existing media files – it simply refers to sections of specific files.



CHAPTER 2: OVERVIEW
METADATA AND MEDIA FILES

 18

Metadata Files

Metadata files are everything media files are not. Depending on your NLE, 
metadata might include project files, bins, sequences, and settings files. 
Metadata files are frequently changed during the course of editing.

Other Files

Some files are not clearly media or metadata. One example might be a title 
graphic created in Photoshop. It is media, but is media that might be modified. 
Usually you should treat such a file as if it were metadata.

Why Sharing Metadata is Different from Sharing Media Files

Most editing applications such as Avid Media Composer, Final Cut Pro, and 
Premiere Pro have no built-in capability to referee what happens if multiple 
users open and try to modify the same file at once. 

For example, if Editor A makes a change in a sequence, and Editor B has the 
same sequence file open, when Editor B saves the sequence, he overwrites all the 
changes that had been made by Editor A. Similarly, if Editor B adds two clips to 
a bin, and Editor C adds two different clips to the same bin, the last editor to save 
the bin is the one whose data is retained. The other editor’s data might get lost. 

Because of such issues, it is generally not safe to simultaneously open the same 
files from more than one workstation if it is possible that one or both users 
might wish to modify the files. Media files are not modified once they are 
created, so it is generally safe for multiple editors to open and view the same 
media files at once. But project files (metadata) are modified almost every time 
they are opened – even as simple an action as moving the play head on a clip 
usually results in a change to a project file. In order to collaborate on a project, 
each editor must usually work with his or her own copy of the metadata files. 

The EditShare system, however, allows multiple users to share project files in 
Shared Project Spaces, which can be used with most NLEs, including Avid 
Media Composer, Final Cut Pro, and Premiere. If your project is stored and 
Shared in a Shared Project Space, you can safely work with projects, bins, and 
sequences that other users are working on. The EditShare system allows 
multiple users to have safe, read-only access to project files while ensuring that 
only one user at a time can write to these files. You can read more about this 
feature in "Chapter 7: Using EditShare with Avid" on page 75 and "Chapter 8: 
Using EditShare with Final Cut Pro" on page 117.
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If you do not use EditShare's project-sharing feature, you can still collaborate on 
projects by having each editor work with his or her own copy of the metadata 
files. Methods for doing this are discussed in the following chapters. 
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Chapter 3: Getting Started as an Editor

This chapter describes the procedures you follow as an editor to work on projects using 
EditShare. You follow these procedures regardless of which NLE you use. Additional 
information specific to Avid, Final Cut Pro, Premiere, and other NLEs can be found in the 
chapters for those systems. These chapters contain many important procedures that you must 
follow in order to avoid damaging your data.

For general information on working with projects in EditShare, see the following topics:

• Administrator Responsibilities

• Preparing OS X (v10.5) Workstations (Macintosh Only)

• Logging in with EditShare Connect

• Connecting to Spaces

• Managing Connections to Spaces

• Migrating Media and Projects to EditShare

• Troubleshooting EditShare Connect

Administrator Responsibilities

Before you use EditShare, your Administrator must do the following:

• Set up the EditShare server.

• Install the EditShare Connect software on your workstation.

• (Macintosh only) Install the DAVE software on your workstation (highly recommended 
for almost all editors).

• (Macintosh only) Run the EditShare Optimizer.

The Administrator should also provide you with the following information:

• The IP address of the EditShare Master server. In some environments, different 
workstations might use different IP addresses to contact the Master server. Always be 
sure to use the proper IP address for the workstation from which you are connecting.

• A username and password to log in with. It is important that no user is ever connected 
to the EditShare server twice at the same time – for example, from two different 
workstations. If you need to work on more than one workstation at a time, the EditShare 
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Administrator should provide more than one username for you to log in 
with. In some environments, usernames to log in with might be allocated 
for each workstation, rather than for each editor.

• One or more Media Spaces to use for your projects. If your project uses 
more than one Media Space (as most do), be sure to find out how they are 
to be used. For example, you might be given one Media Space for 
capturing media, and a separate Media Space for rendered files; or there 
might be several Media Spaces into which different types of media should 
be captured.

• If you are working on a Macintosh workstation, your Administrator 
should also tell you what network protocol (DAVE SMB, Native SMB, or 
AFP) you should use to mount each Media Space. Network protocols and 
DAVE are explained further in the EditShare Administrator's Guide.

Preparing OS X (v10.5) Workstations (Macintosh Only)

With Mac OS X Leopard and Snow Leopard, Apple changed the default way 
users mount, view, and select EditShare Spaces. A few minor changes to the 
Finder preferences help you quickly access these Spaces.

By default, Leopard does not display Connected Servers on the Desktop or 
Connected Volumes on the Finder window sidebar, and new Finder windows 
default to displaying your Home folder.

To configure the Finder preferences, do the following.

TASK

1. Select Finder > Preferences.

 The Finder Preferences window opens. 
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2. In the Show these items on the Desktop list, select Connected Servers.

3. Select New Finder windows open > Computer.
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4. Click the Sidebar tab.

 

5. In the Devices area, select Computer.

6. In the Shared area, select Connected Servers.

7. Close the Finder Preferences window.

8. In the Finder, drag the desktop icon for the EditShare volume to the Devices 
section at the top of the Finder sidebar.

 The network volumes you use most often are available at the top of the 
sidebar and all mounted volumes are displayed in the first view of new Finder 
windows.

NOTE:  Do not try to connect to the EditShare server by clicking its address in the 
sidebar. If you do, the server reports “Connection Failed.”
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Logging in with EditShare Connect

EditShare Connect is an application that runs on your Windows or 
Macintosh OS X workstation and allows you to connect to any Space on any of 
your EditShare servers from one simple interface, and (on Windows) to map it 
to a drive letter. It then remembers which Media Space, Project Space, or other 
Spaces you are connected to (and to what drive letters they are mapped) the next 
time you log in, even from a different workstation, and automatically 
reconnects you to the same Spaces. It also provides limited access to the 
management functions of EditShare, for those users who need them.

See the EditShare Administrator's Guide for instructions on installing EditShare 
Connect on editors' workstations. Since EditShare Connect runs on users' 
workstations, it can easily be updated independently of the EditShare server 
without any risk to your data. For additional information, see "Resetting Your 
Login Count" on page 27.

CAUTION:  Do not connect to EditShare from more than one workstation at a time with 
the same username. This can corrupt your data. If you need to change workstations, 
always log out of EditShare on one workstation before you log in on another one. 

To log in with EditShare Connect, do the following.

TASK

1. Determine the IP address of the Master server port that your workstation is 
connected to.

2. Select Start > Programs > EditShare > EditShare Connect (Windows) or Dock > 
EditShare Connect (Macintosh).

 The Login to EditShare dialog box opens.
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3. Type the IP address of the your workstations’s Master server in the Address 
text box.

 The IP address is remembered and filled in automatically the next time you 
start EditShare Connect.

4. (Option) Select Remember Login for your username and password to be 
remembered and filled in automatically. 

 If your workstation is used by multiple people, deselect this option to 
prevent others from logging in with your information.

5. Type your username and password in the text boxes and click Login.

 Note:  You can change your password after you log in. See "Changing Your 
EditShare Connect Password" on page 27.
EditShare Connect opens.

NOTE:  If no Spaces appear in the EditShare Connect window, the network might 
have been configured incorrectly, and might be trying to use Jumbo Frames on a 
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network that does not support them. For more information, see “Network 
Configuration” in the EditShare Administrator’s Guide.

Resetting Your Login Count

If you try to log into EditShare Connect while you are already logged into at least 
one other workstation, a warning reports that it appears you are already logged 
in. 

This is the same warning that appears in error the next time you try to log in if 
your workstation crashes while you are logged into EditShare Connect or if you 
click Quit on a Mac without logging out. 

If you see this message because your account is active on more than one 
workstation, EditShare strongly recommends that you click No and log in as a 
different user. If you see this message because your workstation crashed or 
because you tried to quit without logging out, it is safe to click Yes and continue 
to log into EditShare Connect.

You can now reset your login count by selecting File > Clear Login Count in 
EditShare Connect. You can also ask your Administrator restart EditShare 
Manager from the Control Panel on the server desktop.

Changing Your EditShare Connect Password

You can change your EditShare Connect password unless you are using Active 
Directory (for more information about Active Directory Support, see the 
EditShare Administrator’s Guide). After you change the password, you are 
logged out of EditShare Connect and need to log in again. Do the following.

TASK

1. Save all your files and close any editing applications.

2. Log into EditShare Connect.
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3. Select File > Change Password.

 The Change Password dialog box opens.

4. Type your current password in the Old Password text box.

5. Type your new password in the New Password text box, and then type it again 
in the Repeat Password text box.

6. Click Change.

 You are logged out of EditShare Connect.

Connecting to Spaces

Much of the EditShare Connect window shows you the EditShare Spaces 
available to you. If there are too many Spaces to fit on the screen at once, you 
can scroll down to see more. You can also click the triangular opener at the right 
side of each group to minimize it, leaving more room for the other groups.
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Macintosh users need to connect with a network protocol. 

CAUTION:  It is very important to connect to your Space with the correct protocol. 
Using the wrong protocol causes difficulties when you try to share files with someone 
using the correct protocol. You might see garbage files and files with spurious names 
and file types. If you need help, see your EditShare Administrator.

To mount a Media Space, Project Space, or other Space, do the following.
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TASK

1. Do one of the following: 
• (Windows) Select a drive letter for the Space from the Mount column.

• (Macintosh) Select the protocol you want to use to connect – AFP, DAVE 
SMB, or Native SMB. Only one of DAVE SMB and Native SMB is available, 
depending on whether your workstation has DAVE installed or not. If 
you know you are supposed to use DAVE SMB for a particular Media 
Space, do not mount it with Native SMB; instead, install DAVE on your 
workstation. 

NOTE:  For some types of Spaces, only one choice is offered – for example, 
AvidMXF, Traditional Avid, and Traditional Premiere Media Spaces can only be 
connected using SMB, and your EditShare Administrator might disable one 
mounting option in order to ensure that everyone uses the correct option. 

NOTE:  When you are using DAVE on Macintosh OS X systems, sometimes it takes 
a little while before you can mount a Media Space to which you have recently been 
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added. If you get an error when trying to mount such a Media Space, try waiting a 
few minutes, or reboot your Macintosh.

2. Click Update This Page.

3. (Option) To disconnect from the Space, select the blank option from the top 
of the list in the Mount column.

Managing Connections to Spaces

You can preserve, update, disconnect, and unmount Spaces. See the following 
topics:

• "Preserving your Connections" on page 31

• "Updating Spaces" on page 32

• "Disconnecting or Unmounting Spaces" on page 33

• "Working with EditShare Spaces" on page 33

• "Logging Out of EditShare Connect" on page 34

Preserving your Connections

Many editors find it helpful to have EditShare Connect remember which drives 
you have mounted during your session, and remount them for you 
automatically the next time you log in.
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To preserve your connections, do the following.

TASK

1. Select an option from the list in the Logout area.

 

2. Click Logout.

Updating Spaces

EditShare Connect does not automatically notice when the Administrator adds 
a user to new Media Spaces and Project Spaces or changes automatic 
Share/Refresh settings. 

Option Description

and save current setup When and you log out, your current drive mounts are remembered and are restored the next 
time you log in on a workstation of the same type (Mac or Windows). This setting is 
remembered the next time you log in.

and clear saved setup When you log out, your current drive mounts are cleared so that the next time you log in, no 
Spaces are mounted automatically for you. The next time you log in, the setting is changed to 
“...and do not touch saved setup.”

and do not touch saved 
setup

When you log out, the list of drive mounts saved on the server is not modified. You might choose 
this option, for example, if you have mounted a set of drives you don't usually use and you don't 
want them mounted again automatically the next time you log in. This setting is remembered 
the next time you log in
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To see such changes, do the following.

TASK

• Do one of the following:
• Click the Update This Page button at the bottom of the window.

NOTE:  This updates the display you see in EditShare Connect; it does not Refresh 
any Media Spaces.

• Log out of EditShare and then log back in.

Disconnecting or Unmounting Spaces

If you are using Advanced Authentication and EditShare Manager is restarted 
while you are connected via EditShare Connect, you cannot mount a new Space 
until you have unmounted all currently mounted Spaces. You can accomplish 
this by closing the NLE, logging out of EditShare Connect, and logging back in, 
but you can also unmount all Spaces manually.

CAUTION:   Do not eject or disconnect the drive that represents the Space from the 
Macintosh Finder or Windows Explorer. If you do, EditShare Connect cannot 
properly notice the unmounting, and it might be difficult to remount the drive.

To disconnect or unmount a Space, do the following.

TASK

1. Select the blank option from list in the Mount column.

 If the Space is not in use, it is unmounted.

If the Space is in use, a message box opens regarding the possibility of lost 
data if you do not save it first; it asks if you want to disconnect anyway. 

2. Do one of the following:
• Click No, find the application that has files open, close them, and then 

repeat Step 1.

• Click Yes.

 NOTE:  If you are using Macintosh OSX 10.4.11, EditShare Connect cannot 
forcibly unmount an EditShare Space on which the workstation has files open, even 
if you tell it to do so. In this case, you must unmount the drive yourself by dragging 
it to the Trash from the desktop.

Working with EditShare Spaces

EditShare Connect also provides access to management functions for EditShare 
Spaces, such as QuickTime Reference Mode and Share and Refresh, as well as 



CHAPTER 3: GETTING STARTED AS AN EDITOR
MIGRATING MEDIA AND PROJECTS TO EDITSHARE

 34

limited administrative capabilities for users who have been authorized by the 
EditShare Administrator to use them.

Logging Out of EditShare Connect

When you log out of EditShare Connect, all of your Media Spaces, Project 
Spaces, and other Spaces are disconnected. Other users can now use EditShare 
Connect to connect to their Spaces, and you can log in on another workstation. 

To log out of EditShare Connect, do the following.

TASK

1. Click the Logout button at the bottom right of the window. 

 If any Spaces are in use, you are asked if you want to force unmount, to leave 
the drives connected, or to stop logging out. 

2. Do one of the following:
• Click No, find the application that has files open, close them, and then 

repeat Step 1.

• Click Yes.

 Your Spaces are disconnected, and your drive mappings are saved. 

NOTE:  Do not use other methods of exiting EditShare Connect, such as the Quit 
menu in OS X. This does not log you out of the server properly, and might cause 
problems when you or another user try to log in again on that workstation.

Migrating Media and Projects to EditShare

You can migrate your existing media and projects to EditShare. You should first 
do the following:

1) Select projects that are active editing assignments.

2) Organize the media in terms of the project it belongs to. Keep projects 
separate that are owned by different clients, or projects covering different 
subject matter. This facilitates editors knowing which Media Spaces to 
mount, which media can be moved or deleted, and where the media 
resides.

3) Decide on a schema: post-production houses might create a Media Space 
for each job, while a news facility might organize by dates or subject 
matter, for example, features, interviews, headlines, and so on.



CHAPTER 3: GETTING STARTED AS AN EDITOR
TROUBLESHOOTING EDITSHARE CONNECT

35

4) Create the Media Spaces you need.

See the following topics:

• "Migrating Avid Media and Projects to EditShare" on page 111

• "Migrating Final Cut Pro Media and Projects to EditShare" on page 122

Troubleshooting EditShare Connect

The following table includes possible solutions to common problems you might 
encounter while using EditShare Connect.

Problem Possible Solution

Error message when you log 
in

• Check the server IP address.
• Make sure the server is running and on the network.
• Check your username and password.

No Spaces visible after you 
log in

• Click the Update This Page button.
• Make sure the Master server and all Expansion servers are running and on the network.
• Try disabling Jumbo Frames, if they are enabled. If that works, your network might not 

properly support Jumbo Frames.
• You might not be a member of any Media Space.

Cannot change automatic 
Share/Refresh setting

• The Administrator might have set the Space for Administrator control only. See your 
EditShare Administrator

Settings forgotten when you 
log out

• Make sure “and save current setup” is selected.
• Click the Save Current Setup button.
• Settings on Windows and Macintosh are kept separately.

Cannot exit the application • Click the Logout button at the bottom right of the EditShare Connect window.

Drives stay connected after 
you log out

• Make sure no application (including your editing application) has a project or document 
on the drive open when you log out.

• Log out by clicking the Logout button at the bottom right of the EditShare Connect 
window.

• Drives connected outside EditShare Connect are not disconnected by EditShare 
Connect.
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Error message when you 
connect to Spaces

• You cannot connect to a Space to which you are already connected.
• (Windows only) You might have another Space or drive mapped to the selected letter. 

Try a different letter.
• The Space might have been removed or your access might have been removed.
• You cannot be logged into a server as two different users at the same time. Check to see 

if you might have a drive mounted as a different user. Logging out of the operating system 
might help.

Some Spaces are not shown • Spaces to which you do not have access are not shown.
• Spaces on servers that are not operating or not on the network are not shown.
• You might be logged in as a different user.

Problem Possible Solution
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Media Spaces are virtual volumes on the EditShare server where your media files are stored 
and shared. You need to create at least one Media Space for storing media files.

See the following topics:

• Using Multiple Media Spaces

• Controlling Access to Media Spaces

• Protecting Media in Media Spaces

• Types of Media Spaces

• AvidMXF Media Spaces

• Avid-Style Media Spaces

• Managed Media Spaces

• Universal Media Spaces

• Unmanaged Media Spaces

Using Multiple Media Spaces

Your EditShare Administrator is responsible for creating the Media Spaces of the proper types 
for your organization, specifying which users can access each Media Space, and deciding 
whether to set a quota on each Media Space to limit the total size of files that can be stored in 
that Space.

The best way to manage media is to give each new project its own Media Space, with the same 
name as the project. This way you know exactly where the media is stored that belongs to a 
particular project, making it easy to manage – and eventually delete – the media from one 
project without affecting the media from another project. Knowing that all the media in a 
particular Media Space can be deleted vastly simplifies media management. In some cases, you 
might even prefer to use multiple Media Spaces for an individual project, to help keep your 
media files better organized or to optimize the use of your EditShare storage. 

Consider the following:

• EditShare highly recommends having separate Media Spaces for rendered files and for 
original media.
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• For an ongoing TV program like a news show, you might have Media 
Spaces for each week of shooting, so old media can easily be deleted 
without affecting newer work.

• To more evenly distribute media across the storage devices, you might 
have separate Media Spaces for different cameras. You might capture 
footage from Camera 1 to one Media Space, from Camera 2 to a second, 
and so on. 

 The EditShare Administrator's Guide has more information about how to set up 
Media Spaces. As an editor, make sure you find out from your EditShare 
Administrator which Media Spaces to use for which purposes.

Controlling Access to Media Spaces

When a Media Space is created, users must be added to the Space in order to 
have access to it. Only users who have been added to the Media Space can 
connect to it over the network or see any of the media in it. The EditShare 
Administrator (or a user to whom the Administrator has delegated this 
authority) can add or remove users to a Media Space at any time.

By default, a user added to a Media Space has full read/write access to the Space. 
However, the Administrator (or designated user) can restrict specified users to 
read-only access to a Media Space. A user with read-only access to a Media 
Space cannot capture or render files into it. All other users still have read/write 
access to that Media Space, and the user still has read/write access to any other 
Media Spaces of which he or she is a member.

Protecting Media in Media Spaces

Although a Media Space is used just like any shared networked drive, it is much 
more complex. On a typical (that is, non-EditShare) networked drive, all users 
looking at the drive see the same contents, and any user can add, change, or 
delete files at any time. Indeed, an EditShare Unmanaged Media Space works 
just this way, for those users who want that. 

However, this can be problematic in a shared environment. For example, one 
user might believe a particular file is unneeded and delete it, unaware that 
another user still needs it. Worse, some NLEs (notably Avid) might cause 
serious data corruption if multiple editors try to work with the same drive at the 
same time.
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EditShare Media Spaces, on the other hand, are designed to allow multiple 
editors to share media safely. This enables editors to work with the same media 
at the same time without confusing the NLE software. It also helps to protect 
against the possibility of one editor accidentally or maliciously deleting, 
modifying, or overwriting media that another user is relying on. 

Different types of Media Spaces provide these protections differently. Each type 
has its own advantages and disadvantages. 

In order to provide this protection, EditShare requires a specific procedure to be 
followed in order to delete, modify, or overwrite data in a Media Space. The 
AvidMXF and Managed Media Space types allow a much simpler procedure 
than Traditional Media Spaces, but even so, organizing and deleting media is an 
operation requiring some attention. 

Types of Media Spaces

EditShare supports several types of Media Spaces, each offering support for 
specific types of NLEs and a different method of managing media. The types 
include the following:

• AvidMXF (for Avid users only); see "AvidMXF Media Spaces" on page 39

• Avid-Style (for Avid users only); see "Avid-Style Media Spaces" on page 48

• Managed (for all NLEs except Avid, such as Final Cut Pro or Premiere); 
see "Managed Media Spaces" on page 48

• AvidMXF (for Avid users only); see "AvidMXF Media Spaces" on page 39

• Universal (for use with EditShare Flow); see your Flow documentation

• Traditional Avid (now seldom used; see "Appendix B: Traditional Media 
Spaces" on page 141)

Your Administrator can also make any Media Space Public, which allows all 
users access. See the EditShare Administrator’s Guide.

AvidMXF Media Spaces

AvidMXF Media Spaces are designed to allow users of Avid editing software to 
work together easily. As the name suggests, these Media Spaces can be used only 
for media stored in the MXF format, not for OMF, AIF, or WAV files. Be sure 
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to set your Avid application to capture video as MXF and audio as PCM (MXF). 
(If you do not make these changes, you cannot capture into an AvidMXF Media 
Space.) The following table describes features of AvidMXF Media Spaces.

If you must capture your media in non-MXF formats, you need to use a 
Traditional Avid Media Space (see "Appendix B: Traditional Media Spaces" on 
page 141) instead. There is no reason that you can't use both types of Media 
Spaces, but there are advantages to using AvidMXF.

When an Avid NLE captures MXF media, it captures it into a folder called Avid 
MediaFiles/MXF/1 (or potentially 2 or 3 if the first folder gets full). However, it 
also sees any media inside other subfolders of the Avid MediaFiles folder. Each 
folder has its own media database file, which Avid automatically updates when 
it creates or deletes media inside that folder. 

EditShare provides you with your own view of that Media Space, and you have 
your own numbered folder into which Avid captures. In your view of the Media 
Space, your own “1” folder is called 1 and you have full access to capture into it 
or delete media files from it. Other users' “1” folders, on the other hand, appear 
with different names, based on the names of the users, for example, max_1. Avid 
can see media in these folders, so you can play the media, mark In and Out 
points, and incorporate the media into your sequences. You cannot modify or 
delete the media there, however, or capture new media into the folders or use 
other tools (such as OS X Finder or Windows Explorer) to copy or move files 
into these folders.

Feature Description

Supported NLE All Avid (Media Composer, Avid Xpress Pro, Symphony Nitris, and so on), only for media 
stored in MXF format (audio as PCM (MXF))

Network Protocol Windows or DAVE SMB only

Access Control Users must be added to the Media Space to have access
Users can be given read-only access
Public option available

User Operations QuickTime Reference mode
Hide user folders

Administrator Operations Protect/Unprotect mode
Maintenance mode

Contents OMFI MediaFiles (not used)
Avid MediaFiles/MXF/1 (folder you own, can capture into and delete from)
Avid MediaFiles/MXF/# (other folders you own and can delete from)
Avid MediaFiles/MXF/user_# (other users’ folders; view only)
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However, in an another user's view of the Media Space, your numbered folders 
appear with different names, and their numbered folders are called “1” and “2” 
and so on, so that their Avid application captures uniquely into that user’s 
folders. 

You can create additional folders inside your MXF folder, with numbered 
names up to three digits (up to “999”). Avid applications generally do this when 
all existing numbered folders have more than 5000 files in them. 

NOTE:  Do not create names with four or more numerals. Names with four or more 
numerals interfere with some important EditShare functions.

Also see the following topics:

• "Making QuickTime Reference Movies from Avid" on page 41

• "Leaving QuickTime Reference Mode" on page 43

• "Hiding User Folders" on page 44

• "Dealing with Corrupted Media by Hiding a User Folder" on page 45

• "Protecting Media with the Protect Function" on page 45

• "Deleting and Organizing AvidMXF Media with Maintenance Mode" on 
page 46

• "Deleting AvidMXF Media" on page 47

Making QuickTime Reference Movies from Avid

A side effect of the way AvidMXF Media Spaces present your data to you is that 
different users see different path names for the same media file. For example, 
user edit1 might see a file captured as Z:\Avid MediaFiles\MXF\1\clip1.mxf, but 
user edit2 would see that same file as Z:\Avid 
MediaFiles\MXF\edit1_1\clip1.mxf. As long as you are only looking at the files 
within your Avid NLE, this is not a problem – each NLE finds the correct media 
file with no difficulty. 

However, if user edit1 were to create a QuickTime reference movie of a 
sequence that uses that clip, and send it to edit2 to review, edit2 would not be 
able to see the media because QuickTime does not know how to locate the 
media in a different folder. 

A workaround is to create special-purpose usernames. See "Making QuickTime 
Movies Using Special-Purpose Usernames" on page 42.
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You can also work around this problem by using QuickTime Reference Mode 
(QRM). See "Making QuickTime Movies with QuickTime Reference Mode" on 
page 42 and "Leaving QuickTime Reference Mode" on page 43.

Making QuickTime Movies Using Special-Purpose Usernames

This is an alternate procedure to making QuickTime movies with QuickTime 
Reference Mode.

TASK

1. Create two new users, called, for example, QTCreate and QTView.

2. Log in as yourself.

3. Render your sequence.

4. Log out.

5. Log in as QTCreate.

6. Create the QuickTime Reference file.

7. Log out.

8. To view the file, log in as QTView.

 NOTE:  Avoid viewing as QTCreate so you don’t conflict with another user who 
might be creating as QTCreate.

Making QuickTime Movies with QuickTime Reference Mode

When you are in QuickTime Reference Mode (QRM) for a Media Space, your 
own numbered folders in that Space temporarily appear the same way that other 
users see them. The media stays the same, but the name of the folder is changed. 
You can then create the QuickTime reference movie you need, and it contains 
references to your media files in a way that other users can use. 

You might also need to enter QRM to play a QuickTime reference movie, if that 
file contains references to files in your numbered media folders.

NOTE:   While in QuickTime Reference Mode for a Media Space, you cannot capture or 
render any new files into that Media Space. Therefore, it is important that you render any 
effects in the sequences you need to make QuickTime reference movies of before entering 
QuickTime Reference Mode.

To place yourself in QuickTime Reference Mode to create QuickTime reference 
movies, do the following.

TASK

1. Render all effects in the sequences you plan to make QuickTime references of.
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2. Close your Avid project.

3. Start EditShare Connect.

4. Click the Disabled button next to each Media Space that contains media you 
plan to include in your QuickTime reference movies.

 

5. Click Update This Page.

 A dialog box opens telling you to log out of EditShare Connect and log back 
in for the changes to take effect.

6. Click OK.

7. Log out of EditShare Connect.

8. Start EditShare Connect and log in again.

9. Open your Avid project again. 

 You can now make the QuickTime reference movies you need.

Leaving QuickTime Reference Mode

To leave QuickTime Reference Mode, do the following.

TASK

1. Close your Avid project.

2. Click the Enabled button next to each Media Space you are ready to return to 
normal.

 A dialog box opens telling you to log out of EditShare Connect and log back 
in for the changes to take effect.

3. Click OK.

4. Log out of EditShare Connect.

5. Start EditShare Connect and log in again.

6. (Option) Open your Avid project again. 
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Hiding User Folders

You might need to isolate which media files you have control of. You can do this 
by using the Hide User Folders function to hide one or more users' numbered 
MXF folders. 

The EditShare Administrator can also hide user folders for any user. This can be 
done when a problem has been discovered and the Administrator wants to hide 
it from other users without bothering them with it. See "Dealing with Corrupted 
Media by Hiding a User Folder" on page 45.

To hide user folders, do the following.

TASK

1. Start EditShare Connect.

2. Click the Hide button next to the Media Space containing the MXF folders you 
want to hide. 

 The AvidMXF Media Management dialog box opens.

3. Select each folder you want to hide.

4. Click OK.

 The Hide button changes to Show All.

5. (Option) Click the Show All button to show all the hidden folders and restore 
normal operations.
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Dealing with Corrupted Media by Hiding a User Folder

Another use for the Hide User Folders function is to handle a situation where 
media in another user's folder has become corrupted or otherwise unusable. 
Normally Avid simply fails to display the corrupted media, but on rare 
occasions it might become impossible to even load a project with such a 
corrupted media file in it. 

You can hide the folder containing the corrupted files until the user who owns 
them fixes the problem. This way Avid does not see the corrupted files. Any 
media in the folders you hide is offline, but the rest of the Media Space is 
available to you.

Follow the instructions in "Hiding User Folders" on page 44.

Protecting Media with the Protect Function

In many environments, it might be inappropriate for a user who captured media 
to be able to delete it. For example, a group of assistant editors might do logging 
and capturing, but they would not be expected to delete captured media.

To protect captured media from being modified by even the user who captured 
it, the EditShare Administrator (or a designated user) can use the Protect 
function. This makes all media already captured by a specific user read-only. 
Such media can no longer be moved, renamed, deleted, or modified by any user, 
including the user who originally created it. The user can still delete any new 
media he or she adds subsequently until the Protect function is run again.

One way to use this might be for the Administrator to Protect the media on a 
daily basis, when the assistant editors are finished capturing. The assistant 
editors could delete erroneously captured files immediately, but after the 
Administrator Protects the media, making changes requires additional 
maintenance.

The Administrator can also Unprotect media created by one or more specific 
users, returning to each creator the ability to move, rename, delete, or modify 
all the files which had previously been Protected.

It is not necessary to use the Protect and Unprotect functions in order to work 
with an AvidMXF Media Space. If you don't use Protect, all your files are always 
under your control. However, Protect is the only way to ensure that media files 
in an AvidMXF Media Space are not mistakenly or maliciously modified. In an 
environment where media files are shared among many users, it can be very 
disruptive if important files are deleted.
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Instructions for the Administrator to Protect and Unprotect AvidMXF Media 
Spaces can be found in the EditShare Administrator's Guide.

Deleting and Organizing AvidMXF Media with Maintenance Mode

Any user who captured files into an AvidMXF Media Space can normally delete 
those files (unless the Media Space has been Protected). But when it's time to 
delete unnecessary files from a Media Space, it can be impractical to require 
each individual editor to participate in “cleaning up.” For example, a Media 
Space might have clips that were captured by many different people, and the 
lead editor wants to delete media that is not in use without having to involve all 
the users who captured the files.

To address this need, the EditShare Administrator (or a designated user) can 
place an AvidMXF Media Space into Maintenance Mode, giving one specified 
user (called the “maintenance user”) the ability to freely move, rename, delete 
and modify files in that Media Space regardless of who originally captured 
them. See "Deleting AvidMXF Media" on page 47. The maintenance user should 
be selected carefully, as he or she has the ability to do great damage to the media.

If you are the maintenance user, you see a change in the names of other users' 
subfolders of the MXF folder. Instead of seeing names such as user2_1, the 
subfolder names change to purely numeric names, such as 5011. This allows 
your Avid application to modify the contents of all the folders, including their 
media databases. A file called maintenance_users.txt is created in the top-level 
folder of the Media Space, providing a table linking the original names of the 
folders to their new names in Maintenance Mode. This helps you to know which 
folders are owned by which users.

It is generally best, if possible, to have all other users besides the maintenance 
user unmount from the Media Space before maintenance begins. If any users 
have the Media Space mounted during maintenance, you might notice the 
following:

• All other users are restricted to read-only access. In fact, an AvidMXF 
Media Space cannot be put into Maintenance Mode while any files are 
being captured or rendered into it, and while in Maintenance Mode it is 
not possible for anyone other than the maintenance user to save any new 
files into the Media Space.

• Other users immediately see the changes being made by the user who is 
doing maintenance. Files might disappear or be moved without warning 
to them. This might be confusing.

• If you have a file open (that is, if you are playing the media from it) when 
the maintenance user attempts to move or delete the file, the operation 
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might not happen as intended. A file cannot be deleted while it is open. It 
should be deleted after it is closed (that is, when you stop playback) but 
this might not be 100 percent reliable.

Deleting AvidMXF Media

To delete AvidMXF media in Maintenance Mode, do the following.

TASK

1. Make sure all other users have unmounted the Media Space from which you 
want to delete media.

2. Have your Administrator place the AvidMXF Media Space into Maintenance 
Mode for a particular user.

3. Open EditShare Connect as the Maintenance Mode user.

4. Start the Avid application.

5. Select the shared project space.

6. Create a new local bin.

7. Copy, duplicate, or move the media you want to delete to the local bin.

8. Delete the media metadata and media files.

9. Close the Avid application.

 NOTE:  You must close the Avid application before the Media Space is taken out 
of Maintenance Mode. After you delete clips, Avid might not modify its media 
databases until the application is closed. If the Media Space is taken out of 
Maintenance Mode first, you can no longer modify the media database files in 
other users' numbered MXF folders.

10. Have the Administrator take the Media Space out of Maintenance Mode.

 The Administrator can save a backup copy of all deleted files into the 
EditShare Trash for possible restoration in case it is later discovered that one 
or more files were deleted that should not have been.

NOTE:  See “Organizing and Deleting Media” in the EditShare Administrator's 
Guide for information about restoring deleted files.
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Avid-Style Media Spaces

Avid-Style Media Spaces were created to emulate the way Avid projects and 
media are shared on Avid's own shared storage systems. See "About Avid-Style 
Media Spaces" on page 98.

Managed Media Spaces

Managed Media Spaces are designed to allow users of non-Avid editing 
software to work together easily, while still protecting files from inadvertent 
modification or deletion. The following table describes features of Managed 
Media Spaces.

In a Managed Media Space, all editors access the same view of the Media Space. 
Files you capture, render, transfer, import, or otherwise create in the Media 
Space are immediately visible to other users. You can create subfolders inside 
the Media Space, and you can move, rename, delete, or modify the files you have 
captured any way you like to organize and manage your media. However, you 
cannot modify files that other users created, and they cannot modify files you 
created. 

Managed Media Spaces do not provide any special folders for your use. You can 
freely create whatever folders you need to organize your media in whatever way 
works for your organization. Most NLE software automatically creates some 

Managed Media Space Feature Description

Supported NLE Final Cut Pro, Adobe Premiere Pro, Media 100, Edius Canopus, Avid (formerly 
Pinnacle) Liquid, and so on (Avid can import from or export to a Managed or 
Unmanaged Media Space)

Network Protocol Any SMB or AFP

Access Control Users must be added to the Media Space to have access
Public option

User Operations None

Administrator Operations Protect/Unprotect mode
Maintenance mode

Contents Created as necessary by NLE
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folders (for example, Final Cut Pro creates a Capture Scratch folder to capture 
media into), and you are free to create any additional folders supported by your 
NLE. 

In a Managed Media Space, you may not rename, move, or delete folders with 
contents. This protects media from accidental deletion. Once the contents of a 
folder have been moved elsewhere or deleted, the folder may be modified.

Do not try to use Managed Media Spaces as a capture or render destination for 
Avid editing software, unless only one editor ever mounts the Media Space at a 
time. If two editors ever mount the Media Space at the same time and run Avid, 
it is very likely that the media database in the Media Space will become 
corrupted, making your media inaccessible until the media database is rebuilt. 
However, it is safe to use a Managed Media Space as a source from which you 
import files into Avid (which stores them in an AvidMXF or Traditional Avid 
Media Space), or as a destination into which to export files from Avid.

Also see the following topics:

• "Tracking Who Controls Which Files in Managed Media Spaces" on page 
50

• "Organizing Media by Tape or Subject" on page 50

• "Protecting Media with the Protect Function" on page 51

• "Deleting and Organizing Managed Media with Maintenance Mode" on 
page 52
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Tracking Who Controls Which Files in Managed Media Spaces

There is no automatic way to see who created (and therefore controls) which 
files. However, you can establish a convention in your organization that allows 
you to easily track who controls which files.

Each editor can make his or her own folder inside the Media Space, and capture 
and render files into only that folder. For example, a Managed Media Space used 
for a Final Cut Pro project could have a folder structure that looks like the 
following:

Max can access Allan’s files, and vice versa, but the two sets of files stay separate. 
In a Managed Media Space, nothing prevents Max from capturing files into 
Allan’s folder. Editors must take responsibility for following the conventions 
established for the organization.

Organizing Media by Tape or Subject

Final Cut Pro editors often want to organize captured media files by tape 
number or subject matter within a single Capture Scratch folder. Even though 
Final Cut Pro only captures into the main Capture Scratch folder, a Managed 
Media Space allows the editor who captured files to move them into any other 
folder in the Media Space.
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Create the media folders structure the way you want it inside the Media Space. 
Then, after you capture some clips, move the media files out of the main 
Capture Scratch folders into those “subject matter” folders. For example, you 
might create the following folder structure for a TV program about 
the Mediterranean.

Files should be properly named and moved before other editors start working 
with them, or else the files might suddenly go offline and other editors have to 
reconnect the clips in their sequences.

Protecting Media with the Protect Function

In some environments, it might be inappropriate for a user who captured media 
to be able to delete it. For example, a group of assistant editors might do logging 
and capturing, but they would not be expected to delete captured media.

In order to protect captured media from being modified even by the user who 
captured it, the EditShare Administrator (or a designated user) can use the 
Protect function. This makes all media already captured by a specific user 
read-only. Such media can no longer be moved, renamed, deleted, or modified 
by any user, including the user who originally created it. The user can still delete 
any new media he adds subsequently, until the Protect function is run again.

One way to use this might be for the Administrator to Protect the media on a 
daily basis, when the assistant editors are finished capturing. The assistant 
editors could delete erroneously captured files immediately, but once the 
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Administrator Protects the media, making changes requires additional 
maintenance.

The Administrator can also Unprotect media created by one or more specific 
users, returning to each creator the ability to move, rename, delete, or modify 
all the files which had previously been Protected.

It is not necessary to use the Protect and Unprotect functions in order to work 
with a Managed Media Space. If you don't use Protect, all files are always under 
the control of the user who created them. However, Protect is the only way to 
ensure that media files in a Managed Media Space are not mistakenly or 
maliciously modified. In an environment where media files are shared among 
many users, it can be very disruptive if important files are deleted.

Instructions for the Administrator to Protect and Unprotect Managed Media 
Spaces can be found in “Protecting Media Spaces” in the EditShare 
Administrator's Guide.

Deleting and Organizing Managed Media with Maintenance Mode

Any user who captured files into a Managed Media Space can normally delete 
those files (unless the Media Space has been Protected). When it's time to delete 
unnecessary files from a Media Space, however, it can be impractical to require 
each individual editor to participate in “cleaning up.” For example, a Media 
Space might have clips that were captured by many different people, and the 
lead editor might want to delete media that is not in use without having to 
involve all the users who captured the files.

To address this need, the EditShare Administrator (or a designated user) can 
place a Managed Media Space into Maintenance Mode, giving one specified 
user (called the “maintenance user”) the ability to freely move, rename, delete 
and modify files in that Media Space regardless of who originally captured 
them. The maintenance user should be selected carefully, as he or she can 
potentially do great damage to the media.

It is generally best, if possible, to have all other users besides the maintenance 
user disconnect from the Media Space before maintenance begins. If any users 
remain connected during maintenance, you might notice the following:

• All other users are restricted to read-only access. No one besides the 
maintenance user can save any new files into the Media Space while it is 
in Maintenance mode.

• Other users immediately see the changes being made by the user who is 
doing maintenance. Files might disappear or be moved without warning. 
This can be confusing.
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• If you have a file open when the maintenance user tries to move or delete 
it, the operation might not happen as intended. A file is not deleted while 
it is open. Consider further the following:

– If the Media Space is mounted using SMB, the file should be deleted 
once it is closed (that is, not being played), but this might not be 
100% reliable.

– If the Media Space is mounted using AFP, the file is not deleted and 
no warning is given to the maintenance user. It appears that the file 
was deleted, but it was not.

When the maintenance is complete, the Administrator can confirm the changes 
and leave Maintenance Mode. A backup copy of all deleted files can be saved in 
the EditShare Trash for possible restoration if it is later discovered that one or 
more files were deleted that should not have been. See “Organizing and Deleting 
Media” in the EditShare Administrator's Guide for information about restoring 
deleted files.

Universal Media Spaces

Universal Media Spaces are only for use with EditShare Flow. For more 
information, see your Flow documentation.

Unmanaged Media Spaces

Unmanaged Media Spaces are designed to provide the simplest possible 
management: none. In an Unmanaged Media Space, all editors access the same 
view of the Media Space. Files you capture into an Unmanaged Media Space are 
immediately visible to other users. You can create subfolders inside the Media 
Space, and you can rename, move, or delete any files inside it, whether you 
created them or not. Any other user with access to the Space can also modify 
your files. No restrictions or controls are available to protect against accidental 
or malicious overwriting of the contents.

The following table describes the features of Unmanaged Media Spaces.
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In general, EditShare recommends using AvidMXF or Managed Media Spaces 
in preference to Unmanaged Media Spaces. If you do choose to use an 
Unmanaged Media Space, you need to coordinate carefully with other members 
of your organization to be sure you do not modify files other editors might be 
relying on.

Unmanaged Media Spaces do not provide any special folders for your use. You 
can freely create whatever folders you need to organize your media in whatever 
way works for your organization. Most NLE software automatically creates 
some folders (for example, Final Cut Pro creates a Capture Scratch folder to 
capture media into), and you are free to create any additional folders supported 
by your NLE. 

Do not try to use Unmanaged Media Spaces as a capture or render destination 
for Avid editing software, unless only one editor ever mounts the Media Space 
at a time. If two editors mount the Media Space at the same time and run Avid, 
it is very likely that the media database in the Media Space becomes corrupted, 
making your media inaccessible until the media database is rebuilt. However, it 
is safe to use an Unmanaged Media Space as a source from which you import 
files into Avid (which stores them in an AvidMXF or Traditional Avid Media 
Space), or as a destination into which to export files from Avid.

Feature Description

Supported NLE Limited support for all NLEs except Avid (Avid can import from or export to a 
Managed or Unmanaged Media Space)

Network Protocol Any SMB or AFP

Access Control Users must be added to the Media Space to have access
Up to 20 users can be limited to read-only access
Public option

User Operations None

Administrator Operations None

Contents Created as necessary by NLE
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Metadata is all files that are not media files. Depending on your NLE, metadata might include 
project files, bins, sequences, and settings files. The essential fact about metadata files is that 
they are frequently changed during the course of editing.

See the following topics:

• Private Files Spaces

• File Exchange Spaces

• Project Sharing with Avid

• Project Sharing with Final Cut Pro, Premiere Pro, and Other NLEs

• Shared Project Spaces

Private Files Spaces

Unless the EditShare Administrator disables this feature, you are provided with a Private Files 
Space on the EditShare server. This is a private Space for your exclusive use. The following 
table describes features of Private Files Spaces.

Your Private Files Space is a private place to store project metadata files on the EditShare 
Server. It is not a place to put media files. In fact, EditShare blocks most media files from being 
stored in your Private Files Space (any file with a *.omf, *.mov, *.aif, *.wav, *.avi, *.mp3 
extension, among others). The EditShare server stores your Private Files Space (as well as that 

Private Files Space Feature Description

Supported NLE NA

Network Protocol SMB or AFP (always use the same protocol: files accessed with SMB might not be properly 
read by AFP, and vice versa)

Access Control Each user has one Private Files folder, accessible only by that user

User Operations None

Administrator Operations All Private Files Spaces can be disabled by the Administrator

Contents Created by user
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of every other user, and the File Exchange Spaces described in the following 
section) on a drive of limited size. If you were to store media on it, you would 
quickly fill the drive and prevent everyone else from using their Private Files 
Spaces.

Private Files Spaces are the safest place on the EditShare Server to store your 
personal metadata files. Only you can access your Private Files Space. No other 
user can erase your project data unless they know your username and password. 
You can access your Private Files Space from any computer on your network, 
which allows you to create, open, or modify your projects from any workstation 
where you can log in. 

It is possible that your access to your Private Files Space has been disabled by 
your Administrator, for example, in a classroom setting. To access your Private 
Files Space, see your EditShare Administrator.

File Exchange Spaces

The SMB File Exchange and AFP File Exchange Spaces are public locations that 
can be read and written to by anyone who logs onto the EditShare Server. On a 
Windows workstation, you see only SMB File Exchange. On a Macintosh, you 
can see both, but you can only connect to SMB File Exchange using Native SMB 
or DAVE SMB. You can connect to AFP File Exchange using AFP. The Spaces 
have different contents, but they serve the same role.

The following table describes features of File Exchange Spaces.

File Exchange Space 
Feature Description

Supported NLE NA

Network Protocol SMB File Exchange: SMB only
AFP File Exchange: AFP only

Access Control All users can freely read and write

User Operations None

Administrator Operations All Private Files Spaces can be disabled by the Administrator

Contents Created by user
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The purpose of the File Exchange Spaces is to allow editors to exchange 
metadata files with each other. For example, you could copy project files, bins, 
or sequences you want to share into a File Exchange Space, and other editors 
who want to work with those files in turn can copy the files into their own 
private Space, that is, their own Private Files Space on the EditShare Server, or 
into a project folder on their own local computer.

Like your Private Files Space, the File Exchange Spaces are not the place to put 
media files. The File Exchange Spaces are located on a drive of limited size, and 
if you were to store media in them, you would quickly fill the drive and prevent 
everyone else from using their File Exchange Spaces. 

The File Exchange Spaces are readable and writable by everybody. Any file put 
there can be modified or deleted by anybody. You should not consider the File 
Exchange Spaces to be secure or safe places to store your personal files. They are 
only places for trading copies of those files. 

NOTE:  At no time should you directly open up project files, bins or sequences from the 
File Exchange Spaces, as there is no guarantee that other editors won’t also do the same 
thing. If two editors open exactly the same project file, bin, or sequence, important data 
might be lost. 

Your access to the File Exchange Space might be disabled by your 
Administrator, for example, in a classroom setting. To access your File 
Exchange Space, see your EditShare Administrator.

Project Sharing with Avid

You can share an Avid projects in a Shared Project Space or in an Avid-Style 
Media Space. 

The process of working with an Avid Shared Project Space is generally as 
follows.

1) The EditShare Administrator creates the Avid Shared Project Space and 
adds users to it.

2) You create an Avid project in the Avid Shared Project Space, set the 
project settings, and Share it using EditShare Connect. See "Creating a 
New Avid Shared Project" on page 58.

3) All users have their own folders within the project and can create bins in 
them.

4) You capture media, create and edit sequences, and perform other 
editing functions.
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5) When the project is complete, the EditShare Administrator deletes the 
project from the Avid Shared Project Space, or deletes the entire 
Space itself.

You can also share Avid projects using Avid-Style Media Spaces instead of 
Shared Project Spaces. See "Sharing Projects with Avid-Style" on page 59.

Creating a New Avid Shared Project

Once the EditShare Administrator has created an Avid Shared Project File 
Space, you can create and share Avid Projects in it by doing the following.

TASK

1. Use EditShare Connect to mount the Avid Shared Project Files Space on the 
P: drive (Windows) or SMB (Macintosh).

2. Mount one or more Media Spaces in which to store captured media and 
rendered files for this new project.

3. Start your Avid application.

 The Select Projects dialog box opens.

4. Click the Folder button and navigate to the Avid Shared Project Space.

 NOTE:  Do not select the Archive folder inside the Space. You cannot Share a 
project inside the Archive folder.

5. Create an Avid project.

 You are the only one who can access the project; it has only a single bin that 
shares the name of the project.

6. Close the project.

7. Start EditShare Connect and click the Avid Management tab.

8. Click the Update This Page button to update the display. 

 The new project appears in the Share Avid Project area.

9. Select the new project and click the Share button.
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10. Return to the Avid application and open the project.

 NOTE:  Once a project has been Shared, do not try to move or rename it. This 
causes your project to stop working correctly. The EditShare Administrator can 
organize projects using EditShare Manager.

Sharing Projects with Avid-Style

Avid-Style Media Spaces, as described in "EditShare Avid-Style Sharing" on 
page 95, let you share media and projects in a manner similar to Avid Unity.

Project Sharing with Final Cut Pro, Premiere Pro, and Other NLEs

In order to use EditShare's Project Sharing features most effectively with NLEs 
other than Avid, it helps to think about projects a little differently than you 
might have in the past. Normally, a project consists of a single project file. That 
is, no matter how many clips, bins, or sequences you have in your project, all the 
information is packaged up in one big project file. Unfortunately, having 
everything in a single project file makes it impossible to give different members 
of a group of editors exclusive control over different parts of a project. This 
makes it very difficult to work collaboratively. Furthermore, as many Final Cut 
editors have experienced, when project files get very large, it can take a long time 
to open them, because the NLE must locate every media file referenced by the 
project file. 

Some other nonlinear editing programs (such as Avid or Edius) create a 
separate file for each bin inside the project. The project itself is represented by a 
Project Folder, which contains the files representing each bin in the project. 
That kind of structure makes it possible to assign specific rights to individual 
bins – each of which represents a different part of the overall Project. 

Although Final Cut Pro and Premiere Pro weren’t designed to work this way, it 
is easy enough to use them this way. Because the NLE allows you to open up 
more than one Project at the same time, you can treat the Project files the same 
way many other NLE programs treat bins.

That is, whereas in Avid you might have one or two bins for rushes and a 
separate bin for each sequence, with the other NLEs you can create a separate 
Project file for each part of the project and open up multiple project files to see 
as much of the Project as you need to see to work on it. A complete Project 
actually ends up being a folder full of smaller Project Files. 

This scheme has the following advantages over the traditional way of working 
with projects:



CHAPTER 5: METADATA SPACES
SHARED PROJECT SPACES

 60

• Different ownership rights can be assigned to each Project file, allowing 
multiple editors to open up the same files at the same time while ensuring 
that only one editor at a time can write to that file.

• You can open only the part of the project that you need to work with, 
saving time by not having to open a huge project to work with only a small 
piece of it.

• Your work is not impaired. If you are working on Act 1 of a program and 
Editor 2 is working on Act 2, each of you can open both your own project 
file (containing the act you are working on), and also an Assistant Editor's 
Rushes Project file, for example, that contains all the rushes and subclips. 
You can copy the clips you need from the Assistant Editors Project into 
your own Act 1 Project file (this only copies clip, subclip and sequence 
references – it doesn't duplicate any media files). You can also work 
directly from the Assistant's Project and drag clips into a sequence that is 
saved in your own Act 1 Project file. And if Editor 2 wants to see what you 
are doing, he or she only needs to open your project and view the 
sequences it contains.

The process of working with a non-Avid Shared Project Space is generally as 
follows:

1) The EditShare Administrator creates the non-Avid Shared Project Space 
and adds users to it.

2) The EditShare Administrator or an editor creates a Project Folder inside 
the Shared Project Space.

3) You have your own folder within the project and can save Project Files in 
them.

4) You capture media, create and edit sequences, and perform other 
editing functions.

5) When the project is complete, the EditShare Administrator deletes the 
project from the Shared Project Space, or deletes the entire Space itself.

Do not try to move or rename a project. This causes your project to stop 
working correctly. The EditShare Administrator can organize projects using 
EditShare Manager.

Shared Project Spaces

Shared Project Spaces are available to help Avid and Final Cut Pro users 
collaborate on projects. Avid Shared Project Spaces and non-Avid Shared 
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Project Spaces have some slight differences due to differences in how the two 
NLE systems manage their metadata, but they also have many similarities.

The following table describes features of Shared Project Spaces.

When editors work together, the ideal workflow is that all editors can work 
simultaneously on the same metadata files, allowing them to instantly see what 
everybody else has created without having to copy files back and forth. In order 
to work collaboratively in this manner, you need to have a way to lock and 
manage project files so that one editor cannot overwrite the work of another. 

The EditShare Administrator creates one Shared Project Space for editors who 
need to work together. You can be a member of as many Shared Project Spaces 
as necessary. Like a Media Space, a Shared Project Space allows multiple users 
to view the same files simultaneously, but it is structured in a very special way 
designed to keep each editor's work safe. When you open up the work of Editor 
2, you have read-only access to Editor 2's work. You can see or copy what Editor 
2 has done. You can even edit Editor 2's clips or sequences directly into your 
own Timeline, but you can never modify Editor 2's work. 

Shared Project Space 
Feature Description

Supported NLE Avid, Final Cut Pro, Premiere Pro

Network Protocol SMB only

Access Control Users must be added to the Project Space to have access

User Operations Share project files (Avid only), Create Project (non-Avid only)

Administrator Operations Manage Shared Project Files Space

Contents Projects as organized by users
Within a user’s view of each project: 
• Root
• User’s folder
• Other users
• Group Bins
• Unprotected bins (Avid) / Unprotected projects (non-Avid)

New Features Group Bins folder
Project browser to help organize bins and project files
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EditShare blocks your workstation from creating media folders in any Shared 
Project Space. As with Private Files Spaces and Shared Project Spaces, it does 
not have enough room to create media files.

See the following topics:

• Folder Name Restrictions

• "Shared Project Space Structure" on page 62

• "Using the Project Browser to Move Files" on page 64

• "Using the Project Browser to Create a New Project" on page 66

• "Pop-Out Project Browser" on page 68

• "Working from Multiple Shared Project Spaces and Multiple Project 
Folders" on page 69

Folder Name Restrictions

Several folder names are restricted from Shared Spaces. These names are 
reserved for EditShare use. Do not name folders with any form of any of the 
following names (that is, any capitalization, spacing, hyphens, and so on):

• Statistics

• Group Bins

• Unprotected Bins

• Other Users

Shared Project Space Structure

When a project has been created in a Shared Project Space, it is given a structure 
that includes the following five special folders:

• Top-level (root) folder: The top-level folder you see inside a project is 
your private Space. You can create new files (Avid Bins, or Final Cut or 
Premiere Pro Project Files) in this folder and add and edit sequences, but 
nothing stored here is visible to other users.

• Your own user folder: Within your project is a folder named with your 
own username (for example, “avid1” or “allan”). Like the top-level folder, 
you can freely edit, organize, and delete bins or project files stored in this 
folder. Unlike the top-level folder, the contents of your user folder are 
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visible, but not writeable, to other users. Other users can see what you are 
working on here, but they cannot modify or delete it.

NOTE:  If you want other users to see bins in a project you have shared, you need to 
move those bins into your user folder.

• Other Users folder: The Other Users folder contains one folder for each 
other user who is a member of the Shared Project Space. This is where you 
look when you want to see the bins and project files that other editors are 
working on – and it is where they look to see your user folder. You can 
freely open files inside the Other Users folder, play back clips and 
sequences, and even include them in your own sequences, but you cannot 
edit them.

• Group Bins folder: The Group Bins folder is a place where all bins or 
project files are read-only to all users. You can move bins and project files 
in and out of the Group Bins folder using the Project Browser (see "Using 
the Project Browser to Move Files" on page 64), but while items are located 
in this folder, they cannot be modified by anybody. If you want to modify 
a bin or project file that's located here, you have to take it out and bring it 
to your own User Folder, then put it back when you are finished 
modifying it.

Group Bins allow you to organize Avid Bins or Final Cut Pro Projects by 
subject matter or some other criteria instead of organizing them by user. 
You might use this folder to store, for example, the bins or project files that 
refer to original captured clips that all users edit into their sequences, to 
logged daily rushes, or to common elements to be shared among many 
editors. You might also put finished rough cuts and fine cuts here so that 
everybody knows what's finished, and where to find it. Group Bins is the 
place where all editors can look to find items that are frequently needed by 
the entire group.

• Unprotected Bins (Avid) or Unprotected Projects (Final Cut): The 
Unprotected Bins and Unprotected Projects folders were designed for 
transferring ownership of bins between editors, but are no longer the best 
way to do this. Unprotected folders are readable and writeable by all 
editors. You can move a file into the Unprotected folder, and another user 
can move the file from the Unprotected folder into his own user folder, 
where he or she can edit it freely.

CAUTION:  Never work with bins or project files that are located in the 
Unprotected folder. Always move the file to your own folder first. Otherwise, it 
is possible that another editor might have the project file open at the same time, 
and whichever editor saves the project last overwrites the changes made by the 



CHAPTER 5: METADATA SPACES
SHARED PROJECT SPACES

 64

other editor. In addition, some current versions of Avid do not allow you to save 
bins in the Unprotected Bins folder. 

EditShare recommends that you do not leave files in the Unprotected 
folder at all. Use it only as a temporary location for changing the 
ownership of a file from one editor to another, or not at all.

The Project Browser now offers a better way to transfer ownership of a bin 
between editors. As a result, the use of the Unprotected folder is no longer 
recommended. 

Using the Project Browser to Move Files

The Project Browser tab in EditShare Connect helps you organize your Shared 
Projects. It provides an interface with your project, similar to that provided by 
Windows Explorer, the Macintosh Finder, or the Avid Bins window.

The following illustration shows project browsers with Avid Shared projects 
(left) and Final Cut Pro Shared projects (right).
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The Project Browser gives you the ability to move bins and project files into and 
out of folders you do not normally have access to modify. You cannot move files 
into or out of other users' folders, or the Group Bins folder, except by using the 
Project Browser. After you move bins or files, or if you reverse the move by 
clicking Undo Give Away, you might need to click the Refresh button to see the 
result.

The Project Browser also offers a view of the entire Shared Project similar to the 
Avid Bins window to users whose NLE does not include such a view.

See the following table for a summary of how to move bins or projects files in 
a project.
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Using the Project Browser to Create a New Project

You can create a new non-Avid project in the Project Browser tab of 
EditShare Connect. 

NOTE:  Avid requires creating a project from within the Avid editing application.

Do the following.

TASK

1. Start EditShare Connect.

2. Mount a non-Avid project Space in the Network Shares tab and click Update 
this page.

Moving bins or projects Procedure

Among folders you created 
at the top level of the project 
or your own user folder

Click the bin or project and then drag it to Windows Explorer, the Finder, Avid, or the 
Project Browser.

From the top level or your 
own user folder to another 
user’s folder

Click the bin or project and then drag it elsewhere in the Project Browser. If you accidentally 
drop the file into the wrong folder, click the Undo button within ten seconds to move the file 
back to its original location.  This time limit prevents any loss of work should the editor to 
whom you gave the bin begin editing in it. The receiving editor might, of course, move the 
bin back into your folder the same way you gave it to him or her.

From another user’s folder to 
you own user folder

By default, you cannot do this. You must get the other user to move the file into your folder 
for you. However, the EditShare Administrator can give individuals the capability to move 
files from another user's folder. If you have been given this capability, drag and drop in the 
Project Browser. 

CAUTION:  Use extreme caution when you use this capability. While this does not destroy 
any work being done in the bin at the time it is moved, the new work is saved in an identi-
cally-named bin in the original editor's Shared Project Files, creating the potential for 
confusion and inconsistency.

Between the top level or 
your own user folder and the 
Group Bins folder

Drag and drop in the Project Browser.

Between the top level or 
your own user folder and the 
Unprotected 
Bins/Unprotected Projects 
folder

Drag and drop in Windows Explorer, the Finder, Avid, or the Project Browser. 

NOTE:  Be careful – if another user is working with the file, you might accidentally cause there 
to be multiple copies, or overwrite their work.

Anywhere else Drag the file to your own user folder first and then to its desired location.
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3. Click the Project Browser tab.

 

4. Select the project Space from the SPSs list, and then click Select Shared Project 
Space.

5. Click New Project.

6. Type a name for the project and click OK.

 The new project appears in the mounted project Space.
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Pop-Out Project Browser

You might want to use the pop-out EditShare Project Browser instead of the 
Project Browser tab built into EditShare Connect. The advantage of the pop-out 
browser is that you can resize it to fit nicely onto your screen among the other 
NLE windows.

To use the pop-out Project Browser, do the following.

TASK

1. Start EditShare Connect, and mount the Shared Project Space that contains 
the project you intend to work on.

2. Click the Pop out button.

 The Project Browser opens.

3. Resize the Project Browser to proportions you like, and then create an NLE 
desktop around the Browser.
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4. To copy project files or entire folders from your local machine to the EditShare 
Project Space, do one of the following:
• Select File > Save Project As and navigate to the Shared Project Space 

where you want the file to be.

• Click the file or folder in the Finder and drag it into the EditShare Project 
Browser.

 A dialog box opens asking if you want to move the files or folders or if you 
want to copy them.

5. If you need a local copy, navigate to the Shared Project Space from your Finder 
and find the files or folders you need. 

 NOTE:  You cannot drag and drop objects out of the EditShare Project Browser 
and you cannot rename a project stored in a Shared Project Space.

Working from Multiple Shared Project Spaces and Multiple Project Folders

You can mount more than one Shared Project Space and work with more than 
one Shared Project folder. The EditShare Project Browser displays the contents 
of all Shared Project Spaces that are currently mounted on your workstation. 
Each Shared Project Space might contain multiple Shared Project folders. 
Clicking the Up arrow in the EditShare Project Browser until the display no 
longer changes reveals all Shared Project Spaces. Inside the Spaces are the 
Shared Project folders, each with its own directory structure, organized for safe 
and easy Project Sharing.



CHAPTER 5: METADATA SPACES
SHARED PROJECT SPACES

 70



Chapter 6: Acting as a Limited Administrator

In general, the EditShare Administrator is responsible for managing EditShare users and 
Media Spaces (see "Chapter 3: Getting Started as an Editor" on page 21). However, sometimes 
the Administrator might choose to delegate certain management tasks for specific Media 
Spaces to other trusted users. For example, the editor in charge of a certain project might be 
given the capability to add users to Media Spaces for that project without needing to involve 
the Administrator. In some organizations, this can greatly streamline your workflow.

If you have been designated a limited administrator and granted these capabilities, you see a 
tab in EditShare Connect labeled Limited Admin. Click this tab to use the administrative 
functions the Administrator has allowed you to use.

See the following topics:

• Limited Administration by Media Space

• Limited Administration by Capability

• Limited Administrative Functions

Limited Administration by Media Space

If you know which Media Space you want to work with, you can exercise limited 
administration by Media Space by doing the following.

TASK

1. Open EditShare Connect, and click the Limited Admin tab.
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2. Select Media Space, and then select the Media Space you want to administer.

 

3. Select the operation you want. See "Limited Administrative Functions" on 
page 73

 Additional options might open below the operation you select.

4. Select additional options.

Limited Administration by Capability

If you know what type of administrative action you want to take, you can 
exercise limited administration by action by doing the following.

TASK

1. Open EditShare Connect, and click the Limited Admin tab.

2. Select Capability.

3. Select the operation you want. See "Limited Administrative Functions" on 
page 73.
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4. Select the Media Space on which you want to perform the operation

 Additional options might open below the operation you select.

5. Select additional options.

Limited Administrative Functions

As a non-Administrator user, you can perform the following limited 
administrative functions. You access them through EditShare Connect.

Type of Media Space Function Additional Options

All Change Quota of Media Space New quota

Add User to Media Space User to add (select one or more)

Remove User from Media Space User to remove (select one or more)
Move Media to Trash Instead of Deleting

AvidMXF Media Spaces Protect Media Created by User User whose media is to be Protected

Unprotect User Media User whose media is to be Unprotected

Enter Maintenance Mode User to gain control of the Media Space

Leave Maintenance Mode None

Managed Media Spaces Protect Media Created by User User whose media is to be Protected

Unprotect User Media User whose media is to be Unprotected

Enter Maintenance Mode User to gain control of the Media Space

Leave Maintenance Mode None

All Traditional Media 
Spaces

Share Media (for user) User for whom to Share (select one or more)

Refresh Media (for user) User for who to Refresh (select one or more)

Unshare Media User to take control of Media Space

Reshare Media Accept or Reject changes
Move Media to Trash Instead of Deleting
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Chapter 7: Using EditShare with Avid

The following topics describe aspects of using EditShare with Avid applications:

• Setting up Avid Workstations

• Digitizing (Capturing) Media

• Collaborating on Avid Projects

• EditShare Avid-Style Sharing

• Avid Media Database Files

• Migrating Avid Media and Projects to EditShare

Setting up Avid Workstations

You need to do the following to configure your Avid workstation:

• Use alldrives or the Avid Launcher to enable Avid to see networked drives. See 
"Enabling Avid Editing Systems to See Networked Drives" on page 76.

• Ensure that Filter Network Drives Based on Resolution is disabled in Avid. See 
"Disabling the Filter Network Drives Based on Resolution Option" on page 77.

• (Windows only) Disable Simple File Sharing. See "Disabling the Simple File Sharing 
Option (Windows Only)" on page 78.

• (Macintosh only) Decide if you will use DAVE. See "Using DAVE (Macintosh Only)" on 
page 86.

• Make sure you are using Windows-compatible file names. See"Using 
Windows-Compatible Names" on page 87.

• If you need to upgrade your Avid software, you must first remove and disable your Avid 
application in the EditShare Connect Avid Management tab. See "Upgrading Your Avid 
Software" on page 87.



CHAPTER 7: USING EDITSHARE WITH AVID
SETTING UP AVID WORKSTATIONS

 76

Enabling Avid Editing Systems to See Networked Drives

By default, Avid applications do not see networked drives. In order to capture 
media onto the EditShare Media Space that you just mounted as a networked 
drive, you must tell your Avid editing system to pay attention to networked 
drives. 

For users of Windows-based Avid systems, there are two ways to do this: 

• Avid Launcher

NOTE:  You must use the Avid Launcher if you are using Avid-Style Media Spaces.

• The alldrives command

The method you use depends on the specific Avid application you are running 
and sometimes on the type of media files you are capturing or importing. In 
many cases, you can use a combination of both methods. Avid systems on 
Macintosh use only the alldrives method.

See the following topics:

• "Avid Launcher" on page 102

• "The alldrives Command" on page 76

The alldrives Command

You can use this method for the following Avid applications and versions:

• Avid Xpress Pro v4 and later (except for some Macintosh OS X versions 
distributed before March 2004)

• Avid Xpress Pro HD

• Avid Xpress DV v3.5 and later (except for some Macintosh OS X versions 
distributed before March 2004)

• Media Composer

• Media Composer Adrenaline

• Symphony Nitris

• NewsCutter

• NewsCutter XP

After you use this method, you should not have to do it again unless you update 
your Avid software to a new (major) version.
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Do the following.

TASK

1. Open a project in your Avid application.

2. Select Tools > Console.

3. Type alldrives and then press Enter.

 A message opens in the Console window that reads, “all drives will be viewed 
as media drives.”

4. If you see a message that reads, “only true drives will be viewed as media 
drives, type alldrives and press Enter again.

5. Select File > Mount All.

 Your application now sees the mapped drives. If there are already media files 
in your Media Space, your system might start scanning the Media Space to 
build a new database. This is normal and completes in a few seconds or 
minutes. 

NOTE:  If the application does not see the mapped drives, select File > Refresh 
Media Directories. If it still does not see the mapped drives, quit the application 
and restart it.

Disabling the Filter Network Drives Based on Resolution Option

To see network drives, you need to verify an option in the Avid application’s 
Media Creation dialog box.



CHAPTER 7: USING EDITSHARE WITH AVID
SETTING UP AVID WORKSTATIONS

 78

Depending on which version of Avid software you are using, Avid might enable 
Filter Network Drives Based on Resolution by default each time you create a 
new project. However, with filtering, the Avid editing application assumes that 
any media that is not on your internal “default media creation drive” has the 
wrong resolution (for example, that it is 1:1 instead of DV, or the opposite) so it 
filters out that drive. To prevent Avid software from filtering like this in the 
future, you should change your default preferences so that Filter Network 
Drives Based on Resolution is automatically deselected every time you create 
a project.

NOTE:  For detailed information about the Media Creation dialog box, see the Help for 
your Avid application.

To deselect Filter Network Drives Based on Resolution and change your default 
settings, do the following.

TASK

1. Start your Avid application and open a project.

2. Select Settings > Media Creation.

 The Media Creation dialog box opens.

3. Click the Drive Filtering & Indexing tab and deselect Filter Network Drives 
Based on Resolution.

4. Click OK.

5. Select File > Open Settings. 

6. Click the Up arrow and navigate to the next level of folders.

7. Double-click the Site Settings folder.

8. Click the Media Creation folder in the Avid Settings folder and drag it into the 
Site Settings folder.

9. Select File > Save Settings.

 Filter Network Drives Based on Resolution is deselected each time you start 
a new project in the future.

Disabling the Simple File Sharing Option (Windows Only)

For proper operation, Avid requires that you disable simple file sharing on your 
Windows workstation, whether or not you are using EditShare. With simple file 
sharing enabled, which is the Windows default setting, permissions settings on 
project files (bins, sequences, and so on) and Media Files are set incorrectly by 
your Avid editing software.

Incorrect permissions might not affect you immediately if you are working by 
yourself and storing all your files locally, but when you copy a project file or 
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media file from one place to another (for example, when you make a backup of 
your project file), you might be unable to open the copy even if you move it back 
to its original location. Similarly, if two users on your computer log in with 
individual usernames and try to access the same project files or media files, they 
receive instant “Access Violation” warnings.

At this point, even turning off simple file sharing won’t solve the problem for 
those files, because the permissions are already set incorrectly.

CAUTION:  When you are working with EditShare – which is designed for multiple 
users to share the same media files and project files – having simple file sharing set 
incorrectly causes major problems almost immediately.

See the following topics:

• "Disabling Simple File Sharing (Windows XP)" on page 79

• "Disabling Simple File Sharing (Windows Vista)" on page 80

• "Disabling Simple File Sharing (Windows 7)" on page 82

Disabling Simple File Sharing (Windows XP)

TASK

1. Click the Start button and select Settings > Control Panel.

2. Double-click Folder Options.

 The Folder Options dialog box opens.

3. Click the View tab.
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4. Scroll to the bottom of the Advanced Settings list.

 

5. Deselect Use simple file sharing (Recommended) and then click OK.

Disabling Simple File Sharing (Windows Vista)

TASK

1. Click the Start button.

2. Select Control Panel > Network and Sharing Center.

 The Network and Sharing Center window opens.
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3. In the Sharing and Discovery area, click the arrow next to File sharing.

 The File Sharing area opens.
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4. Select Turn off file sharing, and then click Apply.

 File sharing area is now disabled.

5. Close the Network and Sharing Center window.

Disabling Simple File Sharing (Windows 7)

TASK

1. Click the Start button.

2. Select Control Panel > Network and Sharing Center.

 The Network and Sharing Center window opens.
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3. In the Change your networking settings area, click Choose Home group and 
sharing options.

 The Change sharing options for different network profiles window opens.



CHAPTER 7: USING EDITSHARE WITH AVID
SETTING UP AVID WORKSTATIONS

 84

4. Click the check mark next to Home or Work.

 The Share with other home computers running Windows 7 window opens.
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5. Click Change advanced sharing settings, and then click Apply.

 The Advanced Settings window opens.
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6. Select Turn off file and printer sharing, and then click Save Changes.

 File sharing is disabled.

7. Close the Network and Sharing Center window.

Using DAVE (Macintosh Only)

Macintosh Avid programs do not work well with the Apple FileSharing 
Protocol (AFP), so you must use some form of Windows networking (SMB) to 
connect your Macintosh Avid to any network storage, including EditShare.

EditShare strongly recommends using Thursby Systems' DAVE software. 
DAVE is a third-party product that replaces the native SMB client built into 
OS X. It provides the fastest, smoothest, and most robust access to media stored 
on an EditShare server. In addition, as of Avid Media Composer Version 2.7.3 
(Avid Xpress Pro Version 5.7.3) and later, the use of DAVE is required. These 
more recent versions of Avid cannot capture to any network storage mounted 
using the Apple native SMB client.
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Versions of Avid earlier than Media Composer 2.7.3 or Avid Xpress Pro 5.7.3 
can work with the native SMB client built into OS X version 10.4 (Tiger), but 
this typically produces frequent spinning-beachball delays as you scrub along 
the Avid Timeline. Especially when you are working with Avid sequences 
longer than 15-20 minutes, or shorter sequences with many cuts and many 
layers, DAVE provides far superior performance.

NOTE:  You should not switch from using the native SMB client to DAVE or vice versa 
once you have put media in a Media Space, as Avid is likely to generate errors upon doing 
so. You also cannot have some workstations using DAVE while others use the native SMB 
client. Decide early on a policy for your organization, either to use DAVE or not, and stick 
to it. 

You can purchase DAVE licenses directly from EditShare. In addition, since 
Thursby releases occasional new releases of its product, EditShare can advise 
you on the best version of DAVE to use as of the time you call. See the latest 
ReadMe on the EditShare web site for recommendations about which DAVE 
version to us.

When you use Avid on a Macintosh system with DAVE, Avid might try to scan 
AvidMXF Media Spaces unnecessarily. EditShare prevents this. Occasionally 
Avid needs to scan a Media Space but doesn’t realize it. You can force the scan 
by selecting File > Refresh Media Directories in the Avid editing application. If 
the EditShare feature that prevents unnecessary scanning causes difficulty, your 
Administrator can disable it. See “Avid Scan Issues” in the EditShare 
Administrator’s Guide.

Using Windows-Compatible Names

Even if your organization uses nothing but Macintosh OS X, EditShare requires 
you to name your files with Windows-compatible names. In Avid, you need to 
select the Use Windows Compatible Names option. For information about 
where to locate this option, see the Help for your Avid application. In addition, 
you should not use non-alphanumeric characters (that is, *?/.-_!#%) in file 
names.

Upgrading Your Avid Software

Before you update your Avid software, you must disable the Avid Launcher in 
EditShare Connect. Do the following.

TASK

1. Log into Windows as Administrator (see "Logging in as Windows 
Administrator for Avid-Style Media Spaces" on page 99).
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2. Start EditShare Connect and log in as any user.

3. Click the Avid Management tab, and select the Avid application (for example, 
avidmediacomposer.exe.

 

4. Click Remove Avid Application.

5. Deselect Enable EditShare Avid Launcher.

6. Update your Avid software, and restart the system if Avid prompts you to.

7. While you are still logged in as Windows Administrator, restart your Avid 
editing application.

8. Enable the Avid Launcher again as described in "Avid Launcher" on page 102.

 NOTE:  You do not have to deselect and reselect Enable EditShare Avid Launcher 
for each Windows user account every time you upgrade your Avid software. You 
only need to do this for the Administrator account.

Digitizing (Capturing) Media

When you digitize (capture) media, you need to direct Avid to put the media 
into the desired AvidMXF Media Space or Traditional Avid Media Space on 
your EditShare server, not on your local hard drive (which no other users can 
see) or in the Avid Shared Project Space (which does not have enough room for 
media). EditShare blocks your Avid application from creating media folders in 
any Project File Space. 

On Windows workstations, EditShare suggests mapping your most-used Media 
Space so that it appears as drive Z. If you connect to more than one Media Space 
simultaneously – for example, if your project has more than one Media Space 
associated with it, such as one for captured media and one for rendered effects 
– be careful to put your media onto the correct drive. 

On Windows, unless you run Avid Launcher, Avid only shows you the drive 
letter that you have mapped to the Media Space and not the full name. If you 
forget which EditShare Media Space corresponds to which drive letter (for 
example, if you’ve captured into Drive Z: and rendered effects into Drive Y:), 
you can always check in EditShare Connect to see the full name of your mapped 
drives.
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See the following topics:

• "Selecting an EditShare Space on Macintosh OS 10.5 (Macintosh Only)" 
on page 89

• "Managing Avid Media Files" on page 90

• "Managing the Avid Media Database" on page 90

Selecting an EditShare Space on Macintosh OS 10.5 (Macintosh Only)

To select an EditShare Shared Project Space in which to save your Avid project 
when you are working on a Macintosh OS 10.5 (Leopard) system, do the 
following.

TASK

1. Start your Avid editing application.

2. Click the folder icon on the right side of the Select Project dialog box.

 The Project Directory dialog box opens.

3. Select your network volume or select your computer and then navigate to 
your network volume.
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4. Select your mounted Shared Project and then click Open.

5. In the Avid application, select a destination for your media files.

 EditShare Spaces, including Media Spaces, automatically appear in the list of 
possible drives in the Media Creation dialog box and the Capture tool.

Managing Avid Media Files

Compared to managing metadata files, managing media files is simpler. You 
only need to store captured files in an Avid MXF Media Space for the project.

You should also review the special considerations described in "Managing the 
Avid Media Database" on page 90.

To manage your media files in your Avid application, do the following.

TASK

1. Connect to the Media Space you want.

2. (Windows only) Map the Media Space to a drive letter, for example, Z.

3. Select the Media Space in the Avid Capture tool as follows:
• (Windows) By drive letter

• (Mac) By name

Managing the Avid Media Database

It is a known Avid issue that the Media Database files created by Avid editing 
applications are vulnerable to corruption as they grow larger. When a Media 
database file gets too large, the Avid application noticeably slows down, and 
eventually the database file becomes corrupted. 

For this reason, Avid officially recommends storing no more than 5,000 media 
files in any given storage volume or Media Space. In fact, Avid applications 
normally create a new MXF subfolder once you reach 5,000 files in any single 
folder. 

EditShare concurs that all users should follow these guidelines. To help you, 
EditShare monitors all Avid Media Spaces and sends the EditShare 
Administrator a warning email when the number of files in a folder might be 
growing too large. 

A few tips on how to keep a smaller number of files in each Media Spaces are as 
follows:
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• Don’t break tapes into hundreds of master clips – use subclips instead. 
Many users are accustomed to a workflow where they log their tapes 
before capturing, and then capture the tapes in dozens or hundreds of 
small clips. Unfortunately, this workflow results in creating dozens or 
hundreds of files for each tape – at least 3 files (one video, two audio) for 
each master clip.

To reduce the number of files you create, EditShare recommends NOT 
logging tapes before you capture them. Instead, you can capture each 
entire tape as a single clip. A complete one-hour DV 25 tape might be 
captured in just 8 files (6 video plus 2 audio). If the tape has a few timecode 
breaks, you might end up with 20 or 30 files. But the number of files 
should be much lower than if you capture a tape in hundreds of small 
master clips.

After capturing an entire tape as one or a few master clips, your loggers or 
assistant editors can break down those master clips into an unlimited 
number of subclips, and give each subclip a useful name that is visible 
when you edit the subclip into your Timeline. Creating subclips doesn’t 
create any additional media files.

• Put rendered files in their own Media Space. Creating a separate Media 
Space for storing rendered effects further reduces the risk of accumulating 
too many files. Consider creating a “Render Space” for each project. This 
can also avoid a problem some Avid users have observed where certain 
types of render files can cause a media database to grow unexpectedly 
large (hundreds of megabytes in size) and become easy to corrupt and 
difficult to rebuild.

Avid has confirmed that this problem has nothing to do with EditShare, 
and in fact, using EditShare to keep your rendered files separate from 
captured media files helps protect you from this problem. If you become 
unable to rebuild the media database with rendered files, you can delete 
the rendered Media Space and rerender what you need without losing 
your captured media files.

Collaborating on Avid Projects

Avid's metadata files take the form of project files, bins, sequences, and 
preferences. Whenever you create a new project with your Avid application, 
Avid creates a folder in the place you specified in the Select Project window, 
with the name you gave to the project. Avid stores these on your local drive by 
default.
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You can override the default and store Avid projects wherever you want, 
however, including in an EditShare Avid Shared Project Space. Inside each Avid 
project folder, Avid creates a settings file that contains information about how 
you have customized your Avid application for that project, and a bin file for 
each of the bins that you create in your project. These folders and files do not 
contain any media clips. They contain only metadata that refer to the media 
clips stored elsewhere, for example, on your EditShare server.

You can store Avid project files on a local hard drive and have the media files on 
EditShare, but project files stored on a local hard drive are only accessible from 
that workstation. You can instead create a project inside your Private Files Space 
on the EditShare server, and save your project files there instead of on your local 
hard drive. This way you can access your project from any server you might log 
in to, but it remains private for your use only.

There are two methods for collaborating on an Avid project with other users:

• You can use Avid Shared Project Spaces (see "Shared Project Spaces" on 
page 60). This allows multiple Avid editors to work simultaneously on the 
very same metadata files without danger.

• You can collaborate on a project by trading Avid bins between editors 
(whether you keep them on your local hard driver or in your Private Files 
Spaces). 

Even if you don't use either of these two techniques for sharing Avid Projects or 
bins, you can still use Avid's Media Tool to find and use new clips that another 
user has captured into a Media Space that you have access to see. You can sort 
clips in the Media Tool by name, date, or tape number. When you find the clips 
you're looking for, drag them into a bin in your current project. This creates a 
new pointer to the clip that you can use. The media file itself is not duplicated. 
See your Avid application Help for more information.

See the following topics:

• "Sharing Avid Projects" on page 92

• "Collaborating by Copying Metadata" on page 93

Sharing Avid Projects

The basic use of Shared Projects Spaces is described in "Shared Project Spaces" 
on page 60. This section provides additional Avid-specific tips on the use of 
Shared Project Spaces.

See the following topics:

• "Set Project Settings Before Sharing" on page 93
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• "Deleting Avid Projects from a Shared Project File Space" on page 93

Set Project Settings Before Sharing

When you Share an Avid Project, EditShare gives a copy of the project settings 
file to each user in the Shared Project Space. These become the initial project 
settings that each user has when first opening the shared project. If you want 
your project to have specific settings that are used by all editors (for example, to 
use the 1080i format and capture with PCM sound), save these settings before 
Sharing the project. Otherwise, each editor has to correct his or her own settings 
later.

Adding Titles to Shared Projects

When you add a title to a sequence in a shared project and save the sequence in 
a shared bin, another user might see the title as offline. To enable other users to 
see a new title, you need to close the bin after you save it. If that doesn’t work, 
select File > Refresh Media Directories in the Avid application.

Deleting Avid Projects from a Shared Project File Space

It is impossible for individual editors to delete an Avid Project from an Avid 
Shared Project Space once the Avid Project has been shared. Only the EditShare 
Administrator can delete a Shared Project. For more details, see the EditShare 
Administrator's Guide.

Collaborating by Copying Metadata

Avid saves each bin you create as a separate file, which contains all the metadata 
information about all the clips and sequences in the bin. You must have a least 
one bin for every Avid project, but editors usually create multiple bins for each 
project.

If you choose not to use EditShare's Avid Project Sharing feature, you can still 
work collaboratively by trading copies of bins among multiple editors, a 
technique that has been used since Avid systems first came out. EditShare 
makes trading bins easy by providing an easily accessible public Space where 
editors can swap bins.

Due to the way Avid stores captured clips, it is difficult for other editors to 
simply look at the Media Space and import the clips they need, as they might 
with other NLEs. It's much easier to create one or more bins full of captured 
clips, and then put a copy of those bins in the Shared Project Files Space on 
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EditShare. Other editors can then copy those bins into their own project folder, 
and have the clips. Note that only the metadata about the clips is being copied 
in this procedure, not the media itself. A single copy of the media remains in the 
Media Space, accessed by all editors.

To work collaboratively, do the following.

TASK

1. Create a project, and capture media into a Media Space.

2. Create sequences in one or more bins.

 It can be helpful to copy specific items into one bin you’re going to share, 
naming it clearly.

3. Save the bin you want to share.

4. Share the Media Space into which you captured the media, and make sure the 
other editor refreshes his or her Space. See "Sharing and Refreshing Media 
Spaces" on page 145.

5. Open the following folders on your desktop:
• The folder where you store your Avid projects

• The Shared Projects Files Space on the EditShare Server

 NOTE:  You can create shortcuts on your desktop to these folders, making them 
easier to find when you need them.

6. Inside the Shared Project Files Space, make a new folder with your name.

7. Copy the bin you want to share from your private Avid Projects Space to the 
new folder in the Shared Project Files Space.

 NOTE:  If you store your Avid Projects files on your local workstation, you can copy 
the bin you want to share to the EditShare Server’s Shared Project Files Space by 
dragging the bin from your local folder to the server folder. Because these folders 
actually reside on two separate volumes (one on your local workstation and one on 
EditShare), when you move the bin from one place to another, Windows and OS X 
copy the bin rather than cutting and pasting. (This might not work if you store your 
Avid Project Files on the EditShare Server.)
 The other editor can now copy the shared bin from the Shared Project Files 
Space on the EditShare server to his or her private Avid Projects Space, can 
open your clips and sequences, and can drag them into another bin.

8. Delete the bin from the Shared Project Files Space on EditShare when it’s clear 
that nobody else needs a copy.
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EditShare Avid-Style Sharing

EditShare offers a way to share Avid media and projects called Avid-Style 
sharing. If you are accustomed to working with Avid Unity, you will find 
EditShare Avid-Style sharing very familiar. This feature is currently enabled 
only for Windows-based Avid systems, although support for Mac-based Avid 
systems will be available in the near future.

This section presents all the information you need about setting up and using 
Avid-Style sharing.

See the following sections:

• Introduction to Avid-Style Sharing

• Avid-Style Workflow

• About Avid-Style Media Spaces

• Creating an Avid-Style Media Space

• Logging in as Windows Administrator for Avid-Style Media Spaces

• Avid Launcher

• Sharing Projects with an Avid-Style Media Space

• Upgrading Your Avid Software

• Restrictions on Modifying Media
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Introduction to Avid-Style Sharing

While EditShare pioneered the first non-Avid system for sharing bins, 
sequences and media, EditShare offers an additional system for collaboration 
with these assets. Avid-Style Sharing provides bin-locking and media sharing 
that works the same way as Avid's Unity storage. 

Each approach has its advantages. For example, the original EditShare way of 
sharing bins via User folders is probably much more secure for schools and big 
organizations where individual editors want some guarantee that their bins and 
sequences cannot be modified by others. Similarly, deleting files and rebuilding 
media databases is both safer and easier with EditShare's Avid MXF spaces. 

If you are an Avid editor accustomed to the way Unity works, however, you do 
not need to learn a new way of doing things. With EditShare's Avid-Style 
Sharing, you get both Avid-Style bin-locking and the Avid way of associating 
media files with the workstation that created them. In addition, with Avid-Style 
Spaces, you get a small performance boost on Windows workstations that can 
be important when ingesting or outputting sequences with six or more audio 
tracks.

With EditShare, you also aren’t forced into using only one approach. For 
example, you can use AvidMXF Media Spaces for your media and Avid-Style 
Media Spaces for your bins.

For Avid projects stored in Avid-Style Media Spaces, any bin can be opened 
Read-Write by the first user who opens it. This is represented in the Avid 
application by a green lock icon on the bin.

Any subsequent users have only Read access, which is represented by a red 
lock icon. 
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Avid-Style Workflow

The general process of using Avid-Style sharing is as follows:

1) Create an Avid-Style Media Space for your Avid project in EditShare 
Manager. See "About Avid-Style Media Spaces" on page 98, "Creating an 
Avid-Style Media Space" on page 98, and “Chapter 10: Creating Media 
Spaces” in the EditShare Administrator’s Guide.

2) Log in as Windows Administrator. See "Logging in as Windows Adminis-
trator for Avid-Style Media Spaces" on page 99.

3) Enable the Avid Launcher in EditShare Connect. See "Avid Launcher" on 
page 102. 

4) Create a new Avid project in the Avid-Style Media Space, and work in the 
project with your shared media. See "Sharing Projects with an Avid-Style 
Media Space" on page 105.
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About Avid-Style Media Spaces

The following table describes features of Avid-Style Media Spaces.

Although media and projects can be stored in a single Media Space, EditShare 
recommends creating a dedicated Avid-Style Media Space just for Avid 
projects. It makes sense to call this Space “Avid Projects.”

Creating an Avid-Style Media Space

Avid-Style Media Spaces, as described in "About Avid-Style Media Spaces" on 
page 98, let you share media and projects in a manner similar to Avid Unity. In 
other EditShare Managers, you store projects in Project Spaces and media in 

Feature Description

Supported NLE Avid v5.x and later. You can use Avid-Style Spaces for either MXF or OMF video media, 
and MXF (PCM), AIF, or WAVE audio.

Network Protocol Windows or DAVE SMB only

Access Control Users must be added to the Media Space to have access. However, unlike with Avid MXF 
Spaces, media is written into directories that correspond with the name of the computer 
that is connecting to the space, not written into user directories.
All media is read-write to all users.
Any user can delete media from any media folder in the Space.

User Operations You must enable EditShare Avid support in your EditShare Connect client to use Avid-Style 
Spaces. If EditShare Avid support is not enabled, you cannot capture media into the Space
You can switch support on and off by selecting or deselecting the EditShare Avid option.

Contents OMFI MediaFiles/Creating (folder present but unwritable to all users)
OMFI Media Files/YourComputerName (folder where your workstation writes OMF files 
when running Avid)
OMFI Media Files/OtherComputerNames (folders where other workstations write OMF 
files when running Avid)
Avid MediaFiles/MXF/1 (folder present but unwritable to all users)
Avid MediaFiles/MXF/YourComputerName.1 (folder where your workstation writes MXF 
files when running Avid)
Avid MediaFiles/MXF/YourComputerName.# (additional folder where your workstation 
writes MXF files when running Avid)
Avid MediaFiles/MXF/OtherComputerNames.# (folders where other workstations write 
MXF files when running Avid)
AvidProjects/ (folder where you should store Avid projects if you want Avid-Style locking)
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Media Spaces. In Avid-Style, however, you store both projects and media in the 
Media Space.

In the Avid-Style Manager, it is possible to create a regular Shared Project Space 
in the Project Spaces tab. In general, EditShare recommends against doing this. 
Education customers, however, might want to use Avid-Style Media Spaces for 
media but use a regular Shared Project Space for projects. In regular Shared 
Project Spaces, when a bin resides in a User Folder, it can be modified or deleted 
only by that user, which might be more suitable in a teaching situation. In a 
project in an Avid-Style Media Space, any user can make changes to any bin, as 
long as they are the first to open it.

To create an Avid-Style Media Space, do the following.

TASK

• Ask your Administrator to create a Media Space for your Avid projects in the 
Avid-Style Manager.

 

NOTE:  EditShare recommends you name the Media Space Avid Projects.

Logging in as Windows Administrator for Avid-Style Media Spaces

To use Avid-Style Media Spaces successfully on systems with multiple users, 
you need to log into your workstation as Administrator. 

You also need to enable the EditShare Avid Launcher while you are thus 
logged in. 

NOTE:  It is not sufficient to run EditShare Connect as Administrator. You must actually 
log into Windows as Administrator.
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On Windows Vista and Windows 7 systems, you might first need to enable the 
Administrator account in the Local Security area so you can log in as 
Administrator. 

One you have enabled EditShare Avid Launcher in EditShare Connect, you can 
log out as Administrator and log back in as a normal user. You must then enable 
EditShare Avid Launcher in EditShare Connect again.

Do the following.

TASK

1. Click the Start menu and select Search.

2. Type Local Security Policy and click the result.

 

The Local Security Policy window opens.

3. Click Accounts: Administrator account status.
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The Administrator account status Properties dialog box opens.

4. Click Enabled, and then click OK.
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5. Log out, and log back in as Administrator.

 

You can now enable EditShare Avid in EditShare Connect to start the Avid 
application in a way that lets you work with Avid-Style Media Spaces. See 
"Avid Launcher" on page 102.

Avid Launcher

EditShare Connect provides a special feature called the Avid Launcher for 
starting Windows Avid applications. You must use the Avid Launcher if you are 
working with Avid-Style Media Spaces.

NOTE:  The way you use Avid Launcher with EditShare version 6 and later has changed 
from previous versions. Make sure you follow this procedure carefully.

To use Avid Launcher, do the following.

TASK

1. Log into your system as Windows Administrator (see "Logging in as Windows 
Administrator for Avid-Style Media Spaces" on page 99).

2. Start EditShare Connect and log in.

3. Mount one or more of the Media Spaces you intend to use.

4. Click the Avid Management tab.

 The Avid Launcher area is in the middle of the tab.
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5. Select Enable EditShare Avid Launcher.

 NOTE:  If you log out as Administrator and log in under your own username, you 
need to enable EditShare Avid Launcher again.
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6. Click the Browse for Avid Application button.

 The Choose Avid application to run dialog box opens.

7. Navigate to your Avid executable, for example, AvidMediaComposer.exe, 
select it, and then click Open.

 NOTE:  You need to do this only the first time you use this feature. It is remembered 
for future sessions.

8. (Option) Only If you have both EditShare and Avid Unity on this workstation, 
select an option you want to use, or if you want to be prompted each time:

 NOTE:  You cannot use Avid-Style and Unity at the same time.
• Always use EditShare Avid-Style spaces - to work in Avid-Style Media 

Spaces or other EditShare Media Spaces

• Always use Unity - to work in Unity or other EditShare Media Spaces

• Prompt user - to be prompted each time.

NOTE:  If you don’t see this list, scroll down in the middle section of EditShare 
Connect, or drag the corner of the application to a larger size.
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NOTE:  This option applies to the workstation, to not the user. 

9. Start the Avid application. 

 NOTE:  If, for some reason, the Avid application icon doesn’t work, you can click 
the Launch Avid Application button in EditShare Connect.
Your Avid application starts. If EditShare Connect is not running, it also starts. 

NOTE:  You must be logged into EditShare Connect before you can run the Avid 
application. If you are not logged in, the EditShare Connect login dialog box opens 
before the Avid application finishes starting up.

NOTE:  If you log out as Administrator and log in under your own username, you 
need to enable EditShare Avid Launcher again.

Sharing Projects with an Avid-Style Media Space

To share projects with an Avid-Style Media Space, do the following.

TASK

1. Log in as Administrator on your workstation. To enable Administrator login on 
Windows 7 systems, see "Logging in as Windows Administrator for Avid-Style 
Media Spaces" on page 99.

2. Start EditShare Connect and mount an Avid-Style Media Space.

3. Enable the EditShare Avid Launcher as described in "Avid Launcher" on page 
102.

 NOTE:  You must enable the Avid Launcher before you start the Avid application.
4. Start the Avid application. 

 NOTE:  If you want to start Avid without using the Avid Launcher, you must 
deselect the Enable EditShare Avid Launcher option.
The Select Project dialog box opens.

5. Create a new External project in the Avid-Style Media Space your system 
Administrator created for your Avid projects. 

 When you open a bin, the lock icons appear – green for unlocked and red for 
locked – and the first user to open the bin can make changes to it. 
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Unlike with regular Shared Project Spaces, you do not have to Share the new 
project for other users to have access to it. 

6. Right-click the bin and select Lock or Unlock. 

 See your Avid documentation for additional information on using locked 
and unlocked bins.

Restrictions on Modifying Media

The following restrictions pertain to an Avid-Style Media Space:

• All files are owned by the members of the Media Space—including media 
files, media database files, project settings and bins—and any user can 
modify or delete the files at the Explorer level. 

• Any bin can be opened Read-Write by the first user who opens it. Any 
subsequent users who open it while it is still open by the first user have 
only Read access. This is represented by a green lock icon on the bin 
opened by the first user, and a red lock icon for subsequent users.

Avid Media Database Files

One of the reasons Avid NLE software is so powerful and robust is that Avid 
programs create a media database in every media folder on every drive. These 
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databases contain essential information about each clip in that folder – the tape 
name or number, the clip name, the media files that make up that clip, and so 
on. Even when drive names or letters change, Avid NLEs know exactly which 
files are where simply by reading the database in each folder. Avid doesn't need 
to actually look at the files themselves once the database has been created.

When working with a local drive, you are largely unaware of the media database 
files. Every time you capture or delete a clip, Avid automatically updates the 
media database at the moment the clip is captured or deleted. 

However, if clips are copied or moved from one drive to another outside of an 
Avid application (for instance, if you are combining clips from two drives), 
when Avid is restarted, all new media files are detected and scanned and the 
database files are then be updated to reflect the new additions. 

If there are only 10 or 20 new clips, scanning the files and updating the database 
takes just a few seconds. But if thousands of new clips are added to a drive, 
scanning can take several minutes. If clips have been deleted from a media 
folder outside of the Avid program, when you start the program again, Avid 
must rebuild the database from scratch, because it doesn't know which files have 
disappeared.

See the following topics:

• "Media Databases and AvidMXF Media Spaces" on page 107

• "Media Databases and Traditional Avid Media Spaces" on page 107

• "When to Copy a Database" on page 109

• "Copying Another User’s Avid Media Database" on page 110

Media Databases and AvidMXF Media Spaces

In AvidMXF Media Spaces, each user captures and renders files into his or her 
own numbered subfolders of the MXF folder. This design ensures that each 
folder's media database is always kept in sync with the media files in that folder, 
thus avoiding the need for frequent rescanning and updating of the databases as 
new files are added by other users.

Media Databases and Traditional Avid Media Spaces

If you are not capturing media using the older Avid OMF format, EditShare 
recommends that you use EditShare's AvidMXF Media Spaces. In this case, you 
can skip the rest of this section.
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For Traditional Avid Media Spaces, media database management is more 
complex. Each editor who is a member of a Traditional Avid Media Space has 
his or her own media database files for each media folder in that Media Space. 
That is, there are multiple copies of the each media database for each media 
folder – one for each user. 

Having independent databases for each user allows editors to freely add new 
clips and render files to a Media Space without affecting the work of other 
editors. When you create or render new clips, your media database is 
automatically updated by Avid to reflect the new clips. 

However, when you Share the new clips with other editors, and those editors 
Refresh their view of the Media Space, the other editors' Avid applications must 
update their databases to reflect the changes. 

If you see only a few new clips when Refreshing, it takes just a few seconds for 
the files to get scanned and for your database to get updated. However, if 
hundreds or thousands of new clips appear when Refreshing – if, for example, 
several assistant editors have been capturing clips overnight – it can take several 
minutes for your Avid to scan all the files and update its database. If multiple 
editors Refresh their Media Space at the same time, the scanning can take longer 
because everyone's Avid is simultaneously inspecting all these new clips and 
updating their own databases. 

Similarly, if just one media clip is deleted, when the Space is Unshared the 
database files of all other editors are rebuilt from scratch to take into account the 
files that are now missing. 

To reduce the amount of time spent rebuilding media database files, EditShare 
allows users to copy Avid media database files in a Traditional Media Space 
from one user to another, avoiding the need for each user's workstation to 
rebuild its media database separately.

When you are copying a media database file from another user, the safest 
procedure is for you to shut down your Avid program. If you need to continue 
working while the copying takes place, it is essential that you unmount the 
Media Space whose database will be updated before it receives the database 
copy. When the copying is completed, you can remount the Media Space by 
selecting File > Mount All in the Avid application.

Editors can copy media database files using EditShare Connect, while 
Administrators can do it using EditShare Manager. Media database files are 
never copied automatically, regardless of your automatic Share and Refresh 
settings.
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When to Copy a Database

You should copy a database in the following situations:

• A new user is added to a Media Space. Let's say you have 4500 clips in a 
Media Space. For many weeks, 5 editors have been members of this Media 
Space, and all 5 editors already have correct and up-to-date media 
database files for that Media Space. But now you add a 6th editor to the 
Media Space. When you Refresh the media files for that new editor, the 
editor sees all 4500 files, but his or her Avid application would normally 
have to scan them to create a new media database. 

Instead, the new editor can get a copy of an up-to-date media database at 
the same time as Refreshing, or any time before starting his or her Avid 
application. (If the editor starts the Avid application after Refreshing 
media files but before copying the media database, his or her Avid 
application creates its own database, defeating the purpose of the copying 
feature).

• Extensive new material is added to a Media Space. Let's say you have 10 
editors working together. Overnight, an assistant editor captures 1000 
clips. After capturing, the assistant editor Shares the new clips so that 
other editors can see them and also Refreshes to be sure she's seeing any 
clips that other editors have Shared since the last time the assistant 
Refreshed. 

If zero files are Refreshed, the assistant's media database file is ready to 
copy to other users once they Refresh their media. If some new files were 
seen after Refreshing, the assistant editor's Avid application has to scan 
those new files to ensure that it is up to date. 

Now, in the morning, when other editors Refresh the Media Space to see 
the new clips that were captured overnight, they should also copy the 
assistant editor's media database file to avoid having to scan the new files.

• Several editors capture simultaneously. Sometimes several editors 
capture clips simultaneously. As each editor works, his or her Avid 
application updates its media database to reflect the clips that have been 
captured on that machine. 

After everyone has finished capturing and all editors have Shared the new 
files they captured, one editor (for example, “editor 1") should Refresh. 
Editor 1 is now seeing all of the new files that have been captured – not just 
his own – so his Avid application now scans the files that other editors 
captured and add them to its media database. Other editors should not 
Refresh yet. Once Editor 1's Avid application finishes scanning, only then 
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should other editors Refresh, and at the same time they should copy the 
media database from Editor 1.

• You delete clips from a Media Space. When clips are deleted from an 
Avid Media Space, all other users should copy the media database from 
the user who did the deleting. Otherwise, their Avid applications rescan 
the database as soon as they notice that media files are missing 

• The Media database is recovering from corruption. It is not unusual for 
Avid media databases to become corrupted. This most often happens due 
to having too many files in a single Media Space, but it can happen for 
other reasons as well. The usual solution to this problem involves deleting 
the Avid media database and allowing Avid to rescan the Media Space. 
However, if even one user still has a working media database, you might 
be able to resume work by copying the media database from that user, 
rather than waiting for your workstation to rescan the media on its own.

If that does not work, and you do need to rescan the Media Space, other 
users should copy your new, uncorrupted media database to their own 
views of the Media Space, rather than having to take the time for their own 
workstations to rescan the media. Even if the other users' media databases 
have not yet been corrupted, it is likely that a newly scanned media 
database is more compact and less susceptible to corruption.

• You change tape name information. If you capture clips with the wrong 
tape name and subsequently change the tape name in Avid's Media Tool, 
Avid does not change the tape name information in the original clip. 
Instead, it updates the information in its media database file. 

You can then have other users copy the media database from the editor 
who changed the tape name. However, once you have modified tape 
names, you must be very careful to always copy media database files from 
a user who has this correct information. If a user ever has to perform a 
complete rescan – because his or her media database file has gotten 
corrupted, or because he has used EditShare's database copying feature 
incorrectly – the information about the change in tape name gets lost. 

Copying Another User’s Avid Media Database

NOTE:  Review the guidelines in "When to Copy a Database" on page 109 before you 
decide to copy a media database.

To copy a media database, do the following.

TASK

1. Close your Avid application.
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2. Refresh the Media Space you want to copy, to be sure you are seeing all shared 
media files in that Space.

3. Open EditShare Connect, and click the Avid Management tab.

4. Select the Media Space you want.

5. Select the name of the editor from whom the database files will be copied. 

 

Be sure to select an editor whose media database files are up-to-date and who 
meets the following criteria:
• Someone who has recently Refreshed the Space

• Someone who does not currently have any Unshared clips, for example, 
recently captured or recently rendered files

NOTE:  If you copy a media database file from someone who has Unshared clips, 
those clips appear to be missing when you start your Avid application and the 
application rescans all the clips.

• Someone whose Avid application has an up-to-date media database 
reflecting all media files that have been Shared in the Media Space.

6. Click Copy.

 The database copies.

7. Restart your Avid application or remount the target Media Space.

 The Avid application sees the new media files without having to scan them 
first.

Migrating Avid Media and Projects to EditShare

You can migrate your Avid media and projects to EditShare. You should first do 
the following:

1) Select projects you want to migrate to the EditShare server.

2) Organize the media in terms of the project it belongs to. Keep projects 
separate that are owned by different clients, or projects covering different 
subject matter. This facilitates editors knowing which Media Spaces to 
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mount, which media can be moved or deleted, and where the 
media resides.

3) Decide on a schema: post-production houses might create a Media Space 
for each job, while a news facility might organize by dates or subject 
matter, for example, features, interviews, headlines, and so on.

4) Create the Media Spaces you need. Make sure that no more than 5000 files 
go into any individual numbered folder inside Avid MediaFiles/MXF/.

You then consolidate or relink the media to EditShare, and migrate the Avid 
project files to a Shared Project Space.

NOTE:  Consolidating copies only the media actually used in the selected clips and 
sequences, and omits media files or parts of media files that are not referred to. If you are 
transferring a project to EditShare that you are still actively working on, you might want 
to relink your files rather than consolidate them.

See the following topics:

• "Consolidating Avid Media to EditShare using the Consolidate/Transcode 
Tool" on page 112

• "Relinking Avid Media to EditShare" on page 114

• "Migrating Avid Project Files to a Shared Project Space" on page 115

NOTE:  If you have existing OMF media you want to transfer to EditShare, EditShare 
recommends transcoding it to MXF so you can use the AvidMXF Media Space rather 
than a Traditional Avid Media Space.

Consolidating Avid Media to EditShare using the Consolidate/Transcode Tool

To move all and only the media connected to a single Avid project, do the 
following.

TASK

1. Start the Avid editing application, and open the project.

2. Select the clip or clips you want.

3. Select Clip > Consolidate/Transcode.

 The Consolidate/Transcode dialog box opens. For detailed information, see 
“Using the Consolidate Command” in the Avid editing application Help.



CHAPTER 7: USING EDITSHARE WITH AVID
MIGRATING AVID MEDIA AND PROJECTS TO EDITSHARE

113

4. Select the Consolidate option in the upper left corner.

5. In the Target Drive(s) area, select the relevant Media Spaces.

6. Select Skip media files already on the target drive.

7. Click the Consolidate button in the lower right corner.

 The Copying Media Files dialog box opens.
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8. Select Relink Master clips to media on the target drive, and then click OK.

 The application creates new media files and new clips that are linked 
according to your selection. Make sure that no more than 5000 files go into 
any one folder.

9. Disconnect the drive from the editing application by doing the following:
• If the drive is internal, rename the Avid MediaFiles folder to Avid Media-

Files.old.

• If the drive is external, unmount it and detach if from the editing appli-
cation.

10. Check the project for offline media.

Relinking Avid Media to EditShare

An alternative to using the Consolidate/Transcode tool is to do the following.

TASK

1. Navigate to the Avid media in Windows Explorer (Windows) or the Finder 
(Macintosh), and copy it to the Media Space you want on the EditShare server.

2. Start the Avid editing application.

3. Select the clip or clips you want.

4. Select Clip > Relink.

 The Relink dialog box opens. For detailed information, see the Avid editing 
application Help.

5. Select options as described in “Relink Options” in the Help and then click OK.
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Migrating Avid Project Files to a Shared Project Space

You can migrate Avid projects to an Avid Shared Project Space on EditShare. 
Do the following.

TASK

1. Make sure your Avid project is in the usual structure, and that you are not 
using any restricted names. 

 For more information on EditShare name restrictions, see "Folder Name 
Restrictions" on page 62. In addition, do not use the following words in folder 
names:

• OMFI

• Avid MediaFiles

• Capture Scratch

• Audio Capture Scratch

• Render Files

In addition, do not use any of the following file name extensions: 

.omf, .mxf, .wav, .avi, .mpg, .mov, .aif, .mp3

2. Copy the project to an Avid Shared Project Space.

3. Start EditShare Connect, and click the Avid Management tab.

4. Click Update this Page.

5. In the Share Avid Project area, select the project, and then click Share.

 The project is now migrated to EditShare.
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Chapter 8: Using EditShare with Final Cut Pro

For information about configuring and using Final Cut Pro, see the following topics:

• Getting the Best Network Performance

• Configuring Final Cut Pro

• Sharing Final Cut Pro Projects

• Sharing Final Cut Project Data by Trading XML Files

• Migrating Final Cut Pro Media and Projects to EditShare

• Common Issues with Final Cut Pro

Getting the Best Network Performance

Final Cut Pro is generally less tolerant of network latency than Avid applications. Getting the 
best performance when editing using network storage can require a little more attention to 
detail when you are setting up your workstations. Consider the following:

• EditShare strongly recommends that Macintosh OS X users use DAVE except when 
working with uncompressed HD media. See the EditShare web site for the correct 
version of DAVE for your system.

• Playback performance is generally better with jumbo frames enabled. See the EditShare 
Administrator’s Guide for more information.

• Optimize your workstation (after installing DAVE) using the OS X optimizer. See the 
EditShare Administrator’s Guide for more information.

Configuring Final Cut Pro

See the following topics about configuring Final Cut Pro:

• "Waveform Cache and Thumbnail Cache" on page 118

• "Auto Save Vault" on page 118

• "Choosing a Media Space as your Scratch Disk in Leopard" on page 118

• "Saving Final Cut Pro Settings" on page 119
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Waveform Cache and Thumbnail Cache

When you select where to put the media files that you are capturing (setting 
Capture Scratch), EditShare recommends that you do not store your waveform 
cache or thumbnail cache files inside an EditShare Media Space. Since these files 
are generally quite small, and are created automatically and quickly by Final Cut 
Pro, there is virtually no value to sharing them with other editors. It is better to 
store them on your local hard drive.

Auto Save Vault

Do not set Final Cut Pro to store your Auto Save files on the EditShare server. 
The Auto Save Vault must be stored on your local hard drive.

Choosing a Media Space Type

You can use Managed or Unmanaged Media Spaces (for details on Media 
Spaces types, see "Types of Media Spaces" on page 39). EditShare does not advise 
using Traditional Final Cut Media Spaces.

Choosing a Media Space as your Scratch Disk in Leopard

To choose an EditShare Media Space as a Scratch Disk in Final Cut Pro on 
Leopard, do the following.

TASK

1. Follow the procedure in "Preparing OS X (v10.5) Workstations (Macintosh 
Only)" on page 22.

2. Open Final Cut Pro, and then select Final Cut Pro > System Settings > Scratch 
Disks.

3. Click Set.

 The Choose a Folder dialog box opens.



CHAPTER 8: USING EDITSHARE WITH FINAL CUT PRO
CONFIGURING FINAL CUT PRO

119

4. Select Devices > YourComputerName.

 

5. Select the Media Space you want to use for capturing and rendering.

Saving Final Cut Pro Settings

EditShare Connect allows Final Cut Pro settings such as Capture Scratch folder, 
auto-render settings, and window layout to travel from workstation to 
workstation with each editor, just like their Media Spaces and projects do. This 
feature works with Final Cut Pro v5 and later.

You should use some discretion when restoring saved Final Cut Pro settings to 
a workstation you don't normally use. Even if everyone in your organization is 
in the habit of saving their settings on the server, there might be specialized 
workstations on which your usual settings would be inappropriate. For 
example, if you normally work on an editing workstation with two large 
monitors, and you temporarily log in on a laptop to give a screening, you might 
not want your usual settings there. And if not all editors are using this feature, 
it's possible that an editor might be upset to find that you have changed his or 
her settings. Your EditShare Administrator should help determine how your 
organization uses this feature.

To save your Final Cut Pro settings, do the following:

TASK

1. Close Final Cut Pro.
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2. Open EditShare Connect.

3. In the Final Cut Pro settings area of the EditShare Connect window, click Save.

4. (Option) To restore previously-saved Final Cut Pro settings to the workstation 
you are using, click Restore, and then start Final Cut Pro.

 Any settings that might have been on the workstation previously are copied 
to a backup file located in the same place as the actual settings file: 
~/Library/Preferences/Final Cut Pro User Data.

Sharing Final Cut Pro Projects

Final Cut Pro stores all of its metadata for each project in a single project file. 
Whenever you first save a new project with your Final Cut Pro application, Final 
Cut creates the project file in the place you specify in the Select Project window, 
with the name you gave to the project. By default, Final Cut Pro stores these on 
your local drive in the /Users/name/Documents/Final Cut Documents folder, 
but you can override the default and store them wherever you want – including 
in an Shared Project folder in an EditShare Final Cut Shared Project Space, 
which allows you to collaborate with other users, or in your Private Files Space, 
which allows you to access your project from any server you might log into, 
while keeping it private for your use only.

The project file does not contain any media clips. It contains only metadata 
which refers to the media clips stored elsewhere, for example, in an EditShare 
Media Space. 

You can store your Final Cut project files on a local hard drive and have the 
media files on EditShare, but project files stored on a local hard drive are only 
accessible from that workstation. You can instead create a project inside your 
Private Files Space on the EditShare server, and save your project files there 
instead of on your local hard drive. This way you can access your project from 
any server you might log in to, but it remains private for your use only.

Two methods for collaborating on a Final Cut project with other users are as 
follows:

• You can use Final Cut Shared Project Spaces (see "Project Sharing with 
Final Cut Pro, Premiere Pro, and Other NLEs" on page 59). This allows 
multiple Final Cut Pro editors to work simultaneously on the very same 
metadata files without danger.

• You can collaborate on a project stored on your local hard drive on in your 
Private Files Space by exporting Final Cut bins as XML files which can be 
imported by other editors into their projects.
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NOTE:  You might experience intermittent “Unknown File” errors if you try to save your 
Final Cut Pro project file (projectname.fcp) to your EditShare shared project space. This 
is a Final Cut Pro limitation. Save your project file to the local hard drive on your Mac, 
close Final Cut Pro, and use the Finder to copy the project file back to the EditShare 
shared project space.

See the following topics:

• "Differences between DAVE SMB and Native SMB" on page 121

• "Project Organization Tips" on page 121

• "Sharing Final Cut Project Data by Trading XML Files" on page 126

Differences between DAVE SMB and Native SMB

In addition to the better performance provided by DAVE SMB, DAVE also 
provides superior handling of permissions information provided by the server. 
If you are using DAVE SMB and you open a project file from another user's 
folder or the Group Bins folder, you see a warning that the project is read-only. 
When you are using Native SMB, this warning is not offered, so you are more 
likely to accidentally spend time working on sequences stored in a project file 
that you cannot then save.

Project Organization Tips

The following tips should help you with organizing project sharing in Final Cut 
Pro:

• If you are working on a big project with hundreds of digitized tapes, it 
probably makes sense to make a few master projects that have all of the 
logged clips and subclips, and then make a new project for each scene or 
sequence that an editor might work on. For example, if you shot 300 tapes 
for a project, you might create one master project called Tapes 1 to 100, 
another called Tapes 101 to 200, a third called Tapes 201 to 300, and then 
perhaps a fourth master project called Music and Graphics Library. Once 
you have populated those projects with raw material, you would rarely 
change them except to add more material. Most editors only open those 
master projects to get access to the logged clips and subclips and copy 
them into a smaller Project.

You then create new Project Files for each new sequence you work on. So 
for instance, you might have one Project called Opening, another called 
Act 1, another called Act 2, and so on (using more descriptive names than 
Act 1 and Act 2). Normally, the editor working on a particular sequence 
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needs to have the project file corresponding to it within his or her own 
user folder, so that changes can be saved.

• When you start a new sequence, consider creating two new Projects: one 
for the raw material that you copy in from master projects to use when 
editing the sequence, and one for the actual sequence. Having just the raw 
material you need means it won't be necessary to open a large master 
project to do your editing (which can save time opening the Project in the 
future and can save system memory). Remember, when you copy clips and 
subclips in from another Project, you are not duplicating any media files. 
You are only duplicating references to those files.

Once you have the clips and subclips needed for the sequence, there is no 
reason to keep the master projects open. The fewer references to clips you 
have open, the better your editing application works.

• When you create revised versions of the sequence, consider moving older 
versions of the sequence into a separate Project file, perhaps named 
something like, Sequence Name – Old Versions. This way, Final Cut Pro 
does not have to open all the old versions of your sequences when all you 
want to see is the latest versions.

• To keep clutter to a minimum, consider creating subfolders within your 
own user folder.

• If you need to make copies of a Final Cut Pro Project File or Avid bin or 
sequence because you want to make changes to it, and it resides in 
somebody else's folder, be sure to give the copy a name that says what 
version of the Project file or bin it is. For instance, include your name and 
the date so that other editors know it's not the original or main version of 
the Project file or bin.

Migrating Final Cut Pro Media and Projects to EditShare

You can migrate your Final Cut Pro media and projects to EditShare. You 
should first do the following:

1) Select projects you want to migrate to the EditShare server.

2) Organize the media in terms of the project it belongs to. Keep projects 
separate that are owned by different clients, or projects covering different 
subject matter. This facilitates editors knowing which Media Spaces to 
mount, which media can be moved or deleted, and where the media 
resides.
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3) Decide on a schema: post-production houses might create a Media Space 
for each job, while a news facility might organize by dates or subject 
matter, for example, features, interviews, headlines, and so on.

4) Create the Media Spaces you need.

You then consolidate or copy the media and projects to EditShare. See the 
following topics:

• "Consolidating Final Cut Pro Media to EditShare" on page 123

• "Copying Final Cut Pro Media to EditShare by Reconnecting" on page 125

• "Migrating FCP Project Files to a Shared Project Space" on page 125

Consolidating Final Cut Pro Media to EditShare

To consolidate FCP media to EditShare, do the following.

TASK

1. Start Final Cut Pro, and select the clips you want to transfer.

2. Select File > Media Manager.

 The Media Manager dialog box opens.
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NOTE:  For detailed information on the Media Manager tool, see your 
Final Cut Pro documentation.

3. In the Media area, select Copy.

4. In the Media Destination area, click Browse, and then navigate to the 
EditShare Media Space you want.

5. Click OK.

 The Save dialog box opens and you are asked for a location in which to store 
the project file. You can store the project file in the same location as the media, 
in your Private Files Space, or in a Shared Project Space.

6. Specify a location, type a name for the project, and then click Save.

 The project is created and the media is copied.

7. Disconnect your source media drives, and then make sure that the media you 
need was transferred.
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Copying Final Cut Pro Media to EditShare by Reconnecting

An alternate way to transfer your media is to copy it and then reconnect the 
media. Do the following.

TASK

1. Select your media folder on the source disk.

2. Mount the Media Space on a Macintosh workstation.

3. Copy the folder to a Media Space on EditShare by dragging it and dropping it 
in the Finder (or use any other method you want).

4. Start Final Cut Pro, and select the clips you copied. 

5. Select File > Reconnect Media

 The Reconnect Files dialog box opens.

NOTE:  For more information on the Reconnect Media option, see your Final Cut 
Pro documentation.

6. Click Locate.

 The Reconnect dialog box opens.

7. Navigate to your EditShare Media Space and select the files you copied.

8. Click Choose.

 The Reconnect Files dialog box reopens, and the files you located are in the 
Files Located area.

9. Click Connect. 

 The copied files are reconnected.

10. Make sure the files you want are successfully transferred.

Migrating FCP Project Files to a Shared Project Space

You can migrate FCP projects to an Final Cut Shared Project Space on 
EditShare. Do the following.
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TASK

1. Make sure you are not using any restricted names. 

 For more information on EditShare name restrictions, see "Folder Name 
Restrictions" on page 62. In addition, do not use the following words in folder 
names:

• Capture Scratch

• Audio Capture Scratch

• Render Files

In addition, do not use any of the following file name extensions: 

.omf, .mxf, .wav, .avi, .mpg, .mov, .aif, .mp3

2. Create a Final Cut Shared Project Space.

3. Copy the project to the shared folder of the Shared Project.

Sharing Final Cut Project Data by Trading XML Files

When you are using Final Cut in the traditional way, where all of your bins and 
sequences for a project are stored in a single project file, you can still export 
individual bins as XML files which can then be imported by another user into 
their application. This is the procedure Final Cut editors have used in the past 
for collaborating with other editors. Shared Project Spaces are generally a more 
efficient way of working collaboratively, but the traditional techniques still work 
for those who choose to use them.

You can also apply the following procedure to sharing newly digitized or 
captured clips. Although other editors would be able to find those clips simply 
by browsing available clips and importing them into their Final Cut project, it 
might be much easier to locate newly digitized or captured clips if the person 
who created them puts an XML copy of the clips into the Shared Project Files 
area. The .xml file might be called john new clips march 15.xml and anybody 
would know that this file contains references to the clips that John captured on 
March 15. 

NOTE:  Only the metadata about the clips is being copied in this procedure, not the media 
itself. A single copy of the media remains in the Media Space, accessed by all editors.

The key to successfully sharing project data is to devise a naming system that 
works for your particular situation and workflow. If you share bins frequently, 
you might find it helpful to establish rigorous conventions for how to name 
sequences and XML files and where to put them in a File Exchange Space, so 
that everyone can easily identify locate the latest sequences or captured clips. 
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Although sequences also contain information about when they were created 
and modified, it's easier if the name of the sequence gives some idea about who 
made it and when.

To trade XML files, do the following.

TASK

1. Create a project and capture media into a Media Space.

2. Create sequences in one or more bins.

 It can be helpful to copy specific items into one bin you’re going to share, 
naming it clearly.

3. Save the bin you want to share.

4. Share the Media Space into which you captured the media, and make sure the 
other editor refreshes his or her Space. See "Sharing and Refreshing Media 
Spaces" on page 145.

5. Select the new bin, and then select File > Export to export the selection as an 
XML file into one of the File Exchange Spaces on the EditShare Server. 

 NOTE:  Make sure you put the XML file into a clearly labeled folder to help keep 
this space organized. Also, you can skip the bin step and export a rough cut 
sequence as XML.
 The other editor now selects File > Import to import the XML file into his or 
her Final Cut Pro application, and then opens the clips and sequences.

6. Delete the bin from the File Exchange Space on EditShare when it’s clear that 
nobody else needs a copy.

 NOTE:  The other editor can also delete the XML file.

Common Issues with Final Cut Pro

Be aware of several common issues with Final Cut Pro. See the following topics:

• "Avoiding Tape Name or Timecode Loss with DV" on page 128

• "Managing Render Files" on page 129

• "Rendering to the Wrong Drive" on page 129

• "Strategies for more Reliable Output" on page 129

• "Avoiding Dropped Frames with Longer DV 25 Clips" on page 130
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Avoiding Tape Name or Timecode Loss with DV

When you are using Final Cut Pro to capture DV 25, DV 50, or DVCPRO HD 
media to any network drive (including an EditShare Media Space), the tape 
name and timecode data might be lost if the media file grows larger than 2 GB. 
This is a limitation of Final Cut Pro, not of EditShare. The same thing happens 
when capturing files to another Macintosh OS X workstation over the network. 
The problem occurs whether you are capturing via FireWire or using a capture 
card such as a Decklink or Kona. 

There are several ways to avoid this problem:

• Use the EditShare-provided DAVE version to connect to EditShare, 
instead of Apple's native SMB client (see your EditShare Administrator). 
Recent versions of DAVE allow Final Cut Pro to capture DV 25, DV 50, 
and DVCPRO HD files over 2 GB in size to a network drive without losing 
the tape name and timecode data.

• If you are capturing through an SDI or analog capture card such as a 
Decklink or Kona, you can choose any other codec for encoding your 
videos. If you choose a codec such as Photo-JPEG or IMX, you can capture 
at about the same data rate (25 Mbit/sec) and quality as DV 25, but tape 
name and timecode information are saved correctly. Photo-JPEG and 
IMX are both excellent offline-quality choices. In addition, IMX also 
meets some users' needs as an online-quality codec, especially IMX 50. 
Both of these codecs play back well even on machines that lack capture 
cards.

• If you are capturing via FireWire, you can transcode your video from DV 
25 to Photo-JPEG or IMX during capture. You simply need to create a new 
Easy Settings or Capture template. However, this might require more 
CPU power than some older workstations are capable of, resulting in 
occasional dropped frames.

• If you prefer to continue using DV 25 or DV 50, EditShare recommends 
you use Final Cut Pro's option to limit the size of media files to prevent 
media files from growing larger than 2 GB. This does not limit the length 
of a captured clip: Final Cut Pro stores the clip in multiple files, each of 
which is under 2GB in size, but it still only creates a single clip. You only 
see the difference if you look at the Capture Scratch folder using the Finder 
or other applications outside of Final Cut Pro.

You can limit the media file size. In System Settings in the Scratch Disks 
tab are several options including one to Limit Capture/Export File 
Segment Size to ____ MB. Make sure that option is selected, and type 2000 
in the text box (2000 MB is 2 GB).
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Managing Render Files

After rendering effects with Final Cut Pro, if you later make changes to your 
sequence, Final Cut normally deletes your older rendered files. However, in the 
following cases, Final Cut cannot delete the obsolete rendered files:

• If you are rendering to a Managed Media Space and your rendered files 
have been Protected, Final Cut Pro cannot delete the obsolete render files.

• If you are rendering to a Traditional Final Cut Media Space and your 
rendered files have been Shared, Final Cut deletes the shortcuts to the 
rendered files, but it cannot delete the Shared files themselves.

The best solution is to use a separate Media Space – ideally an Unmanaged 
Media Space – for rendered files than you use for capturing, and never 
Protect or Share that Media Space. This way you always have the ability to 
delete your own files from this rendering Media Space. Alternatively, you 
can render files to a folder on your local drive.

Rendering to the Wrong Drive

Many users have reported that Final Cut Pro occasionally starts rendering to 
local drives, even though the Scratch Disk settings say that files should be 
rendered to a Media Space on the EditShare. This problem can be solved by 
closing Final Cut Pro and deleting the Final Cut Pro preferences file.

Strategies for more Reliable Output

Final Cut Pro does not necessarily require you to fully render a sequence before 
an Edit to Tape or Print to Video operation. On more powerful computers, for 
lower-resolution video, it can often render many effects on the fly. However, 
when you are using network storage, more CPU power is used to transfer the 
data than Final Cut might expect. This can result in dropped frames during 
output. 

On less powerful computers, or when working with higher-resolution video or 
more complex effects, Final Cut Pro automatically renders the unrendered clips 
before outputting. This can be convenient, but it has the following drawbacks:

• The clips are rerendered every time you Print to Video, which can take a 
long time for sequences requiring a lot of rendering.

• The temporary render files created during this process are neither used 
nor deleted after the Print to Video operation completes, so they can end 
up taking up a lot of disk space.
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To avoid dropped frames and unexpected use of disk space, EditShare 
recommends that you always render your sequence before Printing to Video or 
Editing to Tape, especially when you are working with higher bandwidth video 
such as DVCPRO HD or uncompressed video.

Avoiding Dropped Frames with Longer DV 25 Clips

Since its first version, Final Cut Pro has been susceptible to dropped-frame 
issues when you are capturing. Great effort has been put into tuning the DAVE 
SMB client to avoid dropped frames, and if you work with the EditShare 
provided version of DAVE instead of native SMB or AFP, you are unlikely to 
encounter any dropped-frame issues when capturing at any resolution from 
OfflineRT to DV 25 all the way to Uncompressed SD 10-bit. 

If you choose to work with Native SMB or AFP, however, when you are 
capturing DV 25 media over FireWire it is not unusual to encounter dropped 
frames after about 16 or 17 minutes of capturing. If there is no dropped frame 
at that point, chances are high that there is one at about 34 minutes. This is a 
known issue in Final Cut Pro when you are capturing DV 25 to any network 
drive.

If you are not using DAVE, EditShare strongly recommends capturing media in 
Final Cut Pro in clips under 15 minutes in length. Many editors find that Final 
Cut Pro generally works best with clips under 10 minutes in length.
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Although Premiere Pro somewhat separates out media for different projects (at least in the 
Conformed Audio Files and Render Files folders), you should create a separate Media Space 
on EditShare for media for each project you create in Premiere Pro.

Creating a separate Media Space for every Premiere Pro project is the only way to keep the 
media separate for different projects. With EditShare, you can easily delete all media associated 
with a specific project. If you mix media for different projects, it is very difficult to get rid of 
media for one project while leaving media on the server for another.

If you are a setting up a new EditShare system, EditShare strongly recommends that you use 
Managed Media Spaces for your Premiere Pro media. While Traditional Premiere Pro Media 
Spaces continue to work well, Managed Media Spaces have significant advantages. See 
"Managed Media Spaces" on page 48 for more information about Managed Media Spaces.

See the following topics:

• File Locations

• Mapping Media Spaces as Networked Drives (Windows Only)

• Capturing DV Footage with a Matrox RTX 100 Card

• Sharing Metadata between Two or More Premiere Pro Users

File Locations

By default, if you tell Premiere Pro to put media on a specific drive, for example, the D: drive, 
Premiere Pro puts your media in the folders shown in the following table.

Folder Description

D: Drive/ Captured audio/video files (.avi) don't usually go into their own folder; they go 
onto the drive you designate

/Conformed Audio Files Conformed audio files (.cfa) that are created for each clip you capture

/Adobe Premiere Pro Render Files Audio and video render files
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Mapping Media Spaces as Networked Drives (Windows Only)

This example illustrates the importance of consistently mapping Media Spaces 
as network drives. 

In this example, let's say you create a Media Space called Summer Fun and add 
a user named Samantha to the Summer Fun Media Space.

When Samantha logs onto the EditShare server from a Windows workstation, 
she sees a Media Space called Summer Fun_1. To access Summer Fun_1 in 
Premiere Pro, Sam needs to map the Media Space as a network drive. Windows 
automatically starts naming network drives from the end of the alphabet. By 
default, Summer Fun_1 shows up as the Z: drive.

If Sam assigns the Media Space Summer Fun_1 to the Z: drive, it must be the Z: 
drive wherever Sam is working on the Summer Fun project. When Premiere Pro 
stores captured or rendered files on the EditShare server, the application is not 
going to know that the files are in a Media Space called Summer Fun_1. It's only 
going to know that they're on the Z: drive, or specifically in the Z:/Capture 
folder. If Sam starts her computer on a different day, logs onto the EditShare 
server, and maps Summer Fun_1 as the Y: drive, Premiere Pro won't 
automatically find the files. Sam has to point Premiere Pro to where the files are. 
And when Sam saves her project, from now on Premiere Pro thinks the files are 
on the Y: drive.

Although switching the drive name isn’t disastrous, each time that happens you 
have to point Premiere Pro to the place where the media is located. This can get 
complicated when two or more editors are working on a project. EditShare 
recommends being consistent in mapping EditShare Media Spaces to drives. 
Whenever possible, you should map your EditShare Media Space to the Z: drive.

Capturing DV Footage with a Matrox RTX 100 Card

In Project/Project Settings/Capture, you must be sure to select DV/IEEE 1394 
Capture and not Matrox AVI or Matrox M2V.

If you select either of the other two settings, you get stuttering video. You can 
still, however, set up your project as a Matrox project.
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Sharing Metadata between Two or More Premiere Pro Users

Premiere Pro does not offer any way to export an individual bin, clip, or 
sequence from a project so that another user can import it. To give another 
editor a copy of a sequence you are working on, you must make a copy of the 
entire Premiere Pro Project and put it in a place where the other editor can 
access it, such as the SMB File Exchange Space. The other editor imports the 
entire project into his or her project, a moves the desired parts (for example, a 
bin with clips or sequences in it) to a place where he or she wants to store them 
within the project, and deletes the rest of the imported project: bins, settings, 
effects, and so on.
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Chapter 10: Using EditShare with Other NLEs

You can use Managed Media Spaces with other NLE applications such as Avid (Pinnacle) 
Edition 6, Avid Liquid, or even iMovie. You can also use Unmanaged Media Spaces, but you 
need to exercise care to ensure that editors do not accidentally overwrite or interfere with each 
others' work. Unmanaged Media Spaces do not provide any protection against such events.

See the following topics:

• Capture Locations

• Capturing DV Video in Liquid Edition

Capture Locations

With a Managed Media Space, you can set up any folder structure within the Media Space that 
suits your work flow.

With a Traditional OtherNLE Media Space, EditShare Manager creates two folders inside that 
Space. It’s important to put appropriate files into the appropriate folders. 

You must put all your media files into the Shared Media folder. This includes captured video, 
rendered files, waveform files, thumbnail files, and so on. You should put graphics files, 
photos, mattes, and so on in the Miscellaneous folder.

Only files inside these two directories are shared. Any files outside these folders are only 
accessible to a single user (the one who created the file or put it there).

Capturing DV Video in Liquid Edition

When you use Avid (formerly Pinnacle) Liquid Edition 6 to capture DV video files directly to 
the EditShare Server, you must capture files in the dif format. If you select the avi format, 

Folder Contents

Shared Media folder Captured video, rendered files, waveform files, thumbnail files, 
and so on

Miscellaneous folder Graphics files, photos, mattes, and so on
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frames are dropped and the audio and video become out of sync. This is a 
known issue with Liquid Edition. There is no disadvantage to capturing in the 
dif format. This is, in fact, the purest form of a DV file without any extra avi or 
QuickTime wrappers. It is exactly the data that is on a DV tape.



Appendix A: Communicating with Jabber 
Instant Messenger

It is essential that editors working in a collaborative environment communicate easily with 
each other about such things as newly available clips, sequences ready for review, maintenance 
to be done, and so on. EditShare comes with an optional, built-in Jabber Instant Messenger 
feature available for those users who want to take advantage of it. 

For instance, if you have just finished digitizing some clips, you can tell another editor or 
logger that the clips are available for viewing instantly without having to make a phone call or 
walk down the hall. Similarly, if you want to leave instructions for somebody on the night shift, 
you can send an instant message and when the person on the night shift logs on, he or she gets 
the message. 

Your EditShare Administrator must activate the Jabber Instant Messenger service before you 
can use it.

See the following topics:

• "Installing Jabber Instant Messenger" on page 137

• "Creating an Instant Messenger Account" on page 137

Installing Jabber Instant Messenger

TASK

1. Locate the Jabber/Psi program on your EditShare Utilities CD-ROM.

2. Double-click Jabber/Psi.

Creating an Instant Messenger Account

TASK

1. Double-click the Jabber icon.

 The Psi: Add Account dialog box opens.
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2. Type a username in the Name text box.

3. Select Register New Account, and then click Add.

 The Psi: Register Account dialog box opens.

4. Type an account name in the Jabber ID text box in the following format:

 AccountName@EditShareServerhostname

See your EditShare Administrator if you need help.

5. Type a password in the Password text box, and then type it again in the 
Confirm Password text box.

6. Select Manually Specify Server Host/Port.

7. Type the IP address of the EditShare server in the Host text box.

 You must type the EditShare IP address that corresponds with the subnet 
that you are on; this means that if your workstation’s IP address is 192.168.1.x, 
the EditShare server has an address with the same first three numbers (and it 
is probably 192.168.1.3). If your workstation’s IP address is 192.168.3.x, the 
EditShare server has an address that starts with 192.168.3 (and the last 
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number is probably 3 unless your administrator has changed the default 
EditShare IP addresses).

The Port is filled in automatically.

8. Click Register.
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Appendix B: Traditional Media Spaces

It is more effective to use the other types of Media Spaces rather than Traditional Spaces. 
EditShare users usually find that AvidMXF Media Spaces or Managed Media Spaces serve all 
their needs. It is no longer possible to create a new non-Avid Traditional Media Space

NOTE:  If you are using Avid OMF files and you cannot transcode them to MXF, you need to use a 
Traditional Media Space.

If you are a new EditShare user, you can skip this entire chapter unless your EditShare 
Administrator tells you otherwise.

In a Traditional Media Space, you have your own view of each Media Space. When you add 
files to a Traditional Media Space (by capturing or rendering, for instance), the files are not 
initially visible to other users. In order to make the new files visible to others, you must 
explicitly Share them, and then each other user must Refresh his or her view of the Media 
Space to see the new files that have been added.

NOTE:  The EditShare guides use the capitalized terms Share and Refresh specifically to refer to the actions 
of making files you have stored in a Media Space available to others, and of viewing files recently Shared. 
When the more common everyday uses of the words share and refresh are intended, the terms are not 
capitalized.

Traditional Media Spaces offer an Unshare function to greatly simplify the process of 
organizing or deleting Shared media. 

The following table describes the features of Traditional Media Spaces.

Feature Description

Supported NLE Limited support for all NLEs)

Network Protocol Avid, Premiere Pro: SMB only
Final Cut Pro, Other NLEs: SMB or AFP

Access Control Users must be added to the Media Space to have access
Public option

User Operations Share
Refresh

Administrator Operations Unshare/Reshare
Resolve conflicts
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The Share and Refresh system is how Traditional Media Spaces protect shared 
media files from being mistakenly or maliciously erased. When you Share a 
media file, it is moved to a protected area that cannot be directly accessed or 
modified by any user. In your private view of the Media Space, the file is 
replaced with a shortcut or alias that points to the place where the file was just 
moved. You continue to see the file, but you cannot modify it. When other users 
Refresh, they get their own shortcut to the same common file.

For Avid users particularly, this Share and Refresh system prevents Avid 
applications from being surprised by the sudden appearance and disappearance 
of new media files, which can cause Avid NLEs to scan the new files to update 
their media databases.

Sharing and Refreshing must be performed each time new clips or rendered files 
are added to a Traditional Media Space in order to make the new files available 
to other users and protect them from accidental deletion. If you desire it, 
Sharing and Refreshing can be done automatically at an interval set by the 
EditShare Administrator. Automatic Sharing and Refreshing is not always 
appropriate, however. See "Manually Sharing and Refreshing Media Spaces" on 
page 146 for instructions for manually Sharing files, and for configuring 
Automatic Sharing. 

Once files in a Traditional Media Space have been Shared, some restrictions are 
placed on what you can do with them in order to prevent deleting or modifying 
them in a way that could be harmful to other users. Before you share files, you 

Contents (Avid) OMFI MediaFiles
Avid MediaFiles
Miscellaneous

Contents (Final Cut Pro) Capture Scratch
Render Files
Audio Capture Scratch
Audio Render Files
Waveform Cache
Thumbnail Cache Files
Miscellaneous

Contents (Premiere Pro) Adobe Premiere Pro Preview Files
Capture
Conformed Audio Files
Miscellaneous

Contents (Other NLEs) Shared Media
Miscellaneous

Feature Description
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can directly modify them or even delete them. For instance, you might want to 
do the following:

• Change the name of a file

• Modify the tape or reel name as recorded in the metadata embedded in the 
media file

• Recapture a file to change its color correction or aspect ratio

You should make these changes before you Share the file. If you need to modify 
a file stored in a Media Space after it has been Shared, see "Modifying Files in 
Traditional Media Spaces" on page 144.

NOTE:  In many cases, your non-linear editing system or graphics application allows you 
to move or to modify files that have already been Shared. However, since you only modify 
your own shortcut to the file, and not the file itself, these changes are not seen by other 
users. Such changes do not persist even in your own view of the Media Space, and in some 
cases can cause you or others to be unable to properly Share or Refresh those files.

Also see the following topics:

• "Miscellaneous Folder" on page 143

• "Modifying Files in Traditional Media Spaces" on page 144

• "Sharing and Refreshing Media Spaces" on page 145

• "Manually Sharing and Refreshing Media Spaces" on page 146

• "About Automatic Share and Refresh" on page 147

• "Automatically Sharing and Refreshing" on page 149

• "Administrator Share and Refresh" on page 149

• "Deleting and Organizing Media by Unsharing" on page 150

• "Managing File Names" on page 151

• "Using Traditional Premiere Pro Media Spaces" on page 151

Miscellaneous Folder

Within each Traditional Media Space, EditShare creates a Miscellaneous folder 
in addition to the folders needed for the editing application. In older versions of 
EditShare, this folder was sometimes used to store files such as animations, 
photographs, mattes, and music files that would later be imported into or 
referenced by an editing application. However, it is now simpler to use a 
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Managed or Unmanaged Media Space for such files. As such, EditShare 
recommends not using the Miscellaneous folder on new systems.

Any files stored in the Miscellaneous folder of a Traditional Media Space are 
treated just like other media files stored in the other folders in the Media Space. 
They can be Shared and Refreshed. They must not be modified or deleted after 
being Shared. When the Media Space is deleted, all of the files in its 
Miscellaneous folder are deleted.

EditShare Shares only files that are located within the specific folders for your 
editing application, plus the Miscellaneous folder. See the following table.

Put anything else you want to share in the Miscellaneous folder. If you put files 
anyplace else in the Media Space, they are not Shared and cannot be seen by 
other editors.

Modifying Files in Traditional Media Spaces

While it is often possible to modify files in a Traditional Media Space, especially 
in the Miscellaneous folder, doing so might not have the results you expect.

For example, suppose you have created a graphic called “Opening Title,” put it 
into the Miscellaneous folder as a TIFF or JPG or Photoshop file, and Shared it 
so others can see it. Then later, your executive producer decides you need to 
change the color of text in the title graphic. It would be tempting to simply open 
up the file, change the color, and save the title again with the changes. This will 
not have the results you want.

 If the file has already been Shared, then there is a very good chance (depending 
on the architecture of the program used to edit the file) that a new file will end 
up getting saved in your own “private view” of the Miscellaneous folder within 

NLE Specific Folder

Avid Media files must be in OMFI MediaFiles or in Avid MediaFiles folders 
(which Avid automatically does)

Final Cut Pro Files must be in one of the standard Final Cut Pro folders: Capture 
Scratch, Audio Capture Scratch, and so on

Premiere Pro Files must be in one of the standard media folders: Capture, Conformed 
Audio, Video Render, and Audio Render

Other NLEs Files must be in the Shared Media folder
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that Media Space. This makes that file available to you, but the original version 
of the file remains in the Miscellaneous folder within the “public view” of the 
Media Space, available to everyone else. If you then try to Share your new file so 
that others can see the changes you made, EditShare does not automatically 
replace the old file in the public view with the modified file from your private 
view. The whole idea of EditShare's Share and Refresh system, after all, is to 
protect shared files from just this sort of unilateral modification.

If you really do need to modify a file that has already been Shared, you can do 
one of the following:

• Use your NLE or other application to modify the original file and save it, 
creating a name conflict. The original version remains in the public view 
of the Media Space, and your modified version exists only in your private 
view. To get the modified file to replace the original file in the public 
Space, have your EditShare Administrator resolve the conflict, following 
the instructions in the EditShare Administrator's Guide. This describes the 
procedure that allows the Administrator to replace the original file with 
the modified one.

• Make a copy of the Shared file in a different location, such as a local hard 
drive or a part of the Media Space outside of the Shared folders. Then 
delete the original file, following the procedure described in "Deleting and 
Organizing Media by Unsharing" on page 150. Then you can modify the 
copy of the original file, copy the modified file back to its original location 
in the Media Space, and Share it. After other users subsequently Refresh 
the Media Space, they and their applications see the modified file instead 
of the original one.

• When you modify the file, select File > Save As (instead of Save) to save 
your changed file with a new name. This creates a new file, which you can 
then Share like any other new file. When other editors Refresh the Media 
Space, they see both version of the file and can tell their NLE or other 
applications to use the new version instead of the old version.

NOTE:  Consider using a Managed or Unmanaged Media Space for storing any file that 
is likely to need modifying.

Sharing and Refreshing Media Spaces

The key to safely and correctly sharing media files in Traditional Media Spaces 
is using the Share and Refresh functions. When you create new files in a Media 
Space – perhaps by capturing media from a tape – the files are not made 
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available to other users until you Share the Media Space. In order to see the new 
files, other editors must Refresh their own views of the Media Space. 

Sharing and Refreshing can be done automatically, manually by editors, or a 
combination of both. Manual Sharing and Refreshing gives editors total control 
over exactly when these functions occur. Automatic Sharing and Refreshing is 
available as an option to simplify these procedures in some cases for editors who 
do not want to manage them manually. Administrators have the ability to 
enable, require, or disable this feature for each user and or Media Space on the 
system. You can work either way, or switch back and forth as you perform 
different sorts of tasks. This section provides instructions for both workflows.

Before you Share media, you are able to delete it from within your editing 
application as if it were stored locally on your own workstation. For example, if 
you start digitizing some clips and decide you want to delete them, you actually 
delete them from the EditShare server if you delete them from your bin. 

However, after you have Shared the media, your Media Files effectively become 
read-only to you. You can access them, but you can't delete them; it is now 
assumed that the media might be important to other users. Your editing 
application “thinks” that it can delete shared Media Files, but if you delete 
Shared media either through your editing application or through a file manager 
on your desktop, you are taking away your own access to that media. The files 
go offline, but they won't really be deleted from the EditShare Server. And if you 
simply Refresh your Media Space again, you get all the deleted Media Files back 
again.

To truly delete Media Files, you must follow a specific procedure as discussed in 
"Deleting and Organizing Media by Unsharing" on page 150. 

Manually Sharing and Refreshing Media Spaces

You can share or refresh an individual Media Space or multiple Media Spaces at 
the same time. You do not need to Share and Refresh the same set of 
Media Spaces. 
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To manually share or refresh a Media Space, do the following.

TASK

1. (Avid only) Turn off your Avid editing application before you Refresh to avoid 
freezing or interrupting critical editing tasks (particularly digital cut and 
render). 

2. Select the Media Spaces you want to Share or Refresh by selecting that option 
in the right two columns of EditShare Connect.

 

3. Do one of the following:
• For a single Media Space, click the Now button in the Share or Refresh 

column of the Media Space.

• For multiple Media Spaces, click the Share Checked Media Spaces or 
Refresh Checked Media Spaces button in the Share Management area at 
the bottom left of the window.

• To Share or Refresh all Spaces, select Manual Share or Manual Refresh.

 A message opens in the status box indicating how many files were Shared, 
Refreshed, or found in conflict. 

4. Check the status bar to make sure the operation completed successfully.

5. If files were found in conflict, see your EditShare Administrator.

About Automatic Share and Refresh

If your EditShare Administrator allows it, you can set your Media Spaces to 
automatically Share or Refresh periodically. The EditShare Administrator can 
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also configure your Media Spaces to Share or Refresh automatically, but not give 
you control.

The EditShare Administrator sets the length of time that elapses between each 
Auto Share or Auto Refresh event. These times can be different for different 
Media Spaces.

Automatic Sharing works exactly like manual sharing, with the following 
exceptions:

• Files in the Miscellaneous folder are not automatically Shared. This helps 
protect you from accidentally Sharing files that are not yet ready to be 
Shared. For example, you might create a Photoshop file in the 
Miscellaneous folder, intending to create content in it once and then save 
it (and not modify it again). You would not want the file to be 
automatically Shared before you were finished creating it, because then 
you would not be able to modify it.

• Files are not automatically Shared if they have been modified very recently 
or are smaller than 100 kB in size. This helps prevent Sharing media files 
that are still in the process of being captured.

Automatic Refreshing works exactly like manual Refreshing.

CAUTION:  If you are working with Avid NLEs, EditShare strongly advises you not to 
enable Automatic Refresh for your Media Spaces. Automatic Refresh interrupts your 
work whenever it occurs, and worse, it can result in corruption of project files if your 
system ever Refreshes at the same time you are capturing or rendering files. EditShare 
only makes Automatic Refresh available for Avid Media Spaces in case your facility 
has certain non-Avid machines or users that also need to see Avid media files (such as 
Graphics artists or encoding machines) and for some reason those users or machines 
cannot use Manual Refresh. Most likely, your EditShare Administrator will disable 
Auto Refresh for any Avid Media Spaces, except for users or machines that can use the 
feature safely.

CAUTION:  If you are working with Final Cut Pro, EditShare strongly advises you not 
to enable Automatic Share with DAVE at this time. There is a minor bug in the 
current version of DAVE (at least through version 7.1) that results in any clip that is 
being captured when a Share operation occurs being corrupted so it is not readable by 
Final Cut Pro.

If the Administrator allows it, you can use EditShare Connect to specify, for 
each Media Space to which you have access, whether it automatically Shares, 
Refreshes, Shares and Refreshes, or does none of those. (In some environments, 
the Administrator might not allow you to change this setting.)
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Automatically Sharing and Refreshing

TASK

1. Click the Automatic list for the Media Space you want to control.

 

2. Select one of the following:
• Disabled: The Media Space does not automatically Share or Refresh.

• Share: The Media Space automatically Shares on the schedule estab-
lished by the Administrator, but it does not Refresh.

• Refresh: The Media Space automatically Refreshes on the schedule 
established by the Administrator, but it does not Share.

• Share then Refresh: The Media Space automatically Shares on the 
schedule established by the Administrator, and then Refreshes.

 A message opens in the EditShare status box confirming the change.

NOTE:  You can still Share and Refresh manually whenever you want to.

Administrator Share and Refresh

The EditShare Administrator can Share and Refresh. This should not be 
considered an everyday workflow in most organizations, but might be useful in 
certain circumstances as follows:

• If an editor forgot to Share captured media before leaving for the day, the 
Administrator can Share the media.

• In a school setting, the Administrator might be setting up an editing 
environment for a classroom and want to Refresh a lot of media into a 
Media Space for a large number of students before they arrive.
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• In a rental facility, individual editors renting editing bays might not be 
familiar with EditShare, so the Administrator might Share and Refresh 
for them.

See the EditShare Administrator’s Guide for the procedure for an Administrator 
to Share and Refresh a Media Space.

Deleting and Organizing Media by Unsharing

As mentioned in "Modifying Files in Traditional Media Spaces" on page 144, 
once files stored in a Traditional Media Space have been Shared, you cannot 
directly move, rename, delete, or modify the files. If you try to do so, you only 
affect the shortcuts to the media files, not the files themselves. 

The EditShare Administrator (or a designated user) can Unshare your 
Traditional Media Space. This causes all previously Shared files to become 
owned by you, just as if you captured them and had not yet Shared them. 
Unsharing allows you to freely move, rename, delete, or modify such files. Other 
users do not see the changes immediately (unlike Maintenance Mode for 
AvidMXF and Managed Media Spaces). Before Resharing the media, the 
Administrator has an opportunity to reject changes that you made. Only when 
the change is accepted by the Administrator do other users see those changes.

During the time a Traditional Media Space is Unshared, no users can Share or 
Refresh the Media Space until the maintenance is complete and the EditShare 
Administrator (or other user granted the capability) Reshares the Media Space 
or rejects the changes.

It is generally best, if possible, to have all users disconnect from the Media Space 
before the Administrator Reshares an Unshared Media Space. If any users 
remain connected when the Media Space is Reshared, you might notice the 
following effects:

• Media files might temporarily go offline while the changes made in 
Unshare mode are incorporated into other users’ views. This happens 
even if very few files were actually changed, and lasts longer for Media 
Spaces with more files in them.

• For Traditional Resharing, the Media Space causes the media files to be 
Refreshed in each user's view, but does NOT automatically update the 
Avid media databases. It is recommended, after Resharing a Traditional 
Avid Media Space, that you copy the media database from the user who 
did the maintenance to all other users.
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• If you have a file open that was deleted in Unshare mode (that is, if you are 
playing the media from it) when the Media Space is Reshared, the file 
might not be properly deleted. Consider further the following:

– If the Media Space is mounted using SMB: The file should be deleted 
once it is close (that is, after you stop playing it), but this is not 100% 
reliable.

– If the Media Space is mounted using AFP: The file is not deleted and 
no warning is given to the maintenance user. It appears that the file 
was deleted, but it is still present.

All of these problems can be avoided by simply making sure all users are 
disconnected from the Media Space before Resharing it.

When Resharing, the Administrator (or other user granted the capability) can 
send to the EditShare Trash all files that were deleted while the Media Space was 
Unshared. If it is later discovered that some files were deleted that should not 
have been, it is possible to restore them from the Trash. See the EditShare 
Administrator's Guide for information about restoring deleted files.

Managing File Names

Under some uncommon circumstances, Avid might create media files whose 
names begin with a dot (period). Such files are not Shared and Refreshed, so it 
is important to ensure that Avid does not create media files with such names.

One rule of thumb to prevent such files from getting created is to not create 
sequences whose names begin with a dot. If you ever render such a sequence, the 
render file is normally given a name starting with a dot.

Using Traditional Premiere Pro Media Spaces

If you are a setting up a new EditShare system, EditShare strongly recommends 
that you use Managed Media Spaces for your Premiere Pro media. While 
Traditional Premiere Pro Media Spaces continue to work well, Managed Media 
Spaces have significant advantages. See "Managed Media Spaces" on page 48 for 
more information about Managed Media Spaces.

By default, if you tell Premiere Pro to put media on a specific drive, for example, 
the D: drive, Premiere Pro puts your media in the folders shown in the 
following table.
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EditShare makes one very important change to the default for Traditional 
Media Spaces. It is crucial that you follow the workflow procedure described 
here and in "Setting up Scratch Disks" on page 152 and Naming Clips During 
Capture, or else sharing media files does not work properly.

When you set up a Traditional Premiere Pro Media Space on EditShare, 
EditShare automatically creates the following folders for that project.

• /Capture

• /Conformed Audio Files

• /Adobe Premiere Pro Render Files

• /Miscellaneous

Setting up Scratch Disks

You must place all captured video files in the /Capture folder. This is different 
from how Premiere Pro usually works. If you do not put the video files in the 
/Capture folder, the video files cannot be Shared when you tell EditShare to 
Share them.

When you set the Scratch Disk locations in Premiere Pro, assuming your 
EditShare Media Space is mapped as the Z: drive on your Windows system, your 
capture locations must look like the following. (Note: The Z: drive is just used 
as an example here. Your Media Space could be mapped to any other drive 
letter.)

Folder Description

D: Drive/ Captured audio/video files (.avi) don't usually go into their own folder; they go 
onto the drive you designate

/Conformed Audio Files Conformed audio files (.cfa) that are created for each clip you capture

/Adobe Premiere Pro Render Files Audio and video render files

Drive Contents

Z:/Capture Capture Files

Z:/ Conformed Audio Files

Z:/ Video Render Files
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Do not specify Z:/Conformed Audio Files as the location for the .cfa files. If you 
do, Premiere Pro creates another Conformed Audio Files folder inside the one 
created by EditShare.

Do not specify Z:/ AudioRender Files or Z:/Video Render Files as the location 
for the render files. If you do, Premiere Pro creates a new Render Files folder 
inside the ones created by EditShare.

NOTE:  These considerations do not apply if you use a Managed Media Space for your 
Premiere Pro files. In a Managed Media Space, you can create any folder structure that 
suits your workflow.

Naming Clips During Capture

Premiere Pro allows you to name your clips anything you choose. That’s helpful 
for creating descriptive names that clearly identify the clips, but it can be 
problematic in an environment where clips are shared; it's entirely possible for 
two users to create clips with the same name. This wouldn't matter if the two 
clips belonged to separate projects. But it would create a conflict if the two clips 
belonged to the same Media Space.

When two or more editors are capturing clips on the same project, it’s a good 
idea to include some unique characters (like the editor's username or initials) in 
all clip names. 

If the you choose not to follow this naming technique, you should at least Share 
and Refresh frequently. Enabling frequent automatic Sharing and Refreshing 
can help with this. As long Editor A is seeing all of the clips that have been 
created by Editors B and C, if a clip name already exists and it has been shared, 
Premiere Pro won't let Editor A create a clip by the same name.

Z:/ Audio Render Files

Drive Contents
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 A B C D E F G H I J K L M N O P Q R S T U V W X Y Z

A
Administrator

responsibilities 14, 21
Alldrives method with Avid applications 76
Auto Save Vault

saving on local hard drive 118
Automatic Share and Refresh 149
Avid

upgrading software 87
Avid applications

collaborating on projects 91
configuring EditShare workstations for 75
copying another user’s media database files 110
copying metadata 93
deleting projects from Shared project Space 93
digitizing with 88
disabling Media Creation setting 77
disabling simple file sharing 78
enabling to see networked drives 76
enabling to see networked drives using alldrives 76
enabling to see networked drives using Avid Launcher 102
managing file names 151
managing the Avid Media Database 90
media database files 107
migrating media to EditShare 112, 114
migrating projects to EditShare 115, 125
preparing to migrate media and projects to EditShare 111
saving your project 89
selecting Media Space in Capture tool 90
settings for sharing projects 93
shared projects workflow 15
sharing projects 92
using DAVE with 86
using Windows-compatible names with 87
when to copy media database files 109

Avid Launcher
disabling before upgrading Avid software 87

Avid Launcher method with Avid applications 102
Avid Media Creation setting, disabling 77
Avid media database files

described 106
Avid Media files

managing 90
Avid Unity 102
AvidMXF Media Space

deleting and organizing media in 46

described 39
hiding user folders in 44
hiding user folders to deal with corrupted media 45
making QuickTime movies in 41
protecting media in 45

Avid-Style Media Space
described 48, 98
sharing projects in 57, 59, 98, 105
using Avid Launcher with 102

B
Browser

project, creating a new project in 66
project, displaying Shared Project Spaces in 69
project, moving files in 64
project, pop-out 68

C
Cache files

storing 118
Capability

limited administration by 72
Capture folder

setting up in Premiere Pro 152
Capture locations

in Other NLE Media Spaces 135
Capture Scratch folder in Managed Media Space 51
Capture tool (Avid)

selecting Media Space in 90
Captured files

moving into other folders 50
Capturing

DV footage in Premiere Pro 132
naming clips during in Premiere Pro 153
with Avid 88

Changes to Spaces
updating after 32

Clearing login count 27
Collaborative editing

communicating about 137
Connecting to any Media Space 25
Connections to Spaces

preserving 31
Corrupted Media

Index
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hiding folders that include 45

D
Database files

Avid, media 106
DAVE

project sharing on Final Cut Pro 121
using with Avid 86
using with Final Cut Pro 117

Deleting media
in AvidMXF Space 46
in Managed Media Spaces 52

Digitizing
with Avid 88

Disconnecting Spaces 33
Documentation 9
Dropped frames

avoiding in Final Cut Pro 130
DV footage

capturing in Premiere Pro 132
DV formats

issues in Final Cut Pro 128

E
EditShare

Documentation 9
Technical Support 10

EditShare Administrator 14
EditShare Connect

accessing Limited Administrative functions 73
Avid Launcher in 102
changing password 27
connecting to Spaces with 28
copying media database files in 107, 110
creating a new project in 66
disconnecting Spaces in 33
Limited Admin tab in 71
logging into 25
logging out of 34
migrating Avid projects in 115
opening pop-out browser from 68
preserving connections with 31
Project Browser tab in 64
resetting login count 27
saving Final Cut Pro settings in 119
sharing and refreshing Media Spaces in 146
Space management functions in 33
troubleshooting 35
unmounting Spaces in 33
updating 32
viewing shared project in 58

EditShare Project browser 68

EditShare Spaces 12

F
File Exchange Spaces

described 56
File sharing

disabling in Vista 80, 82
disabling in Windows XP 79

Files
media 17
metadata 18
other types 18
sharing metadata vs media 18

Filter Network Drives Based on Resolution option 77
Final Cut Pro

avoiding dropped frames 130
best network performance 117
configuring Auto Save Vault location 118
configuring settings 119
configuring, choosing a Scratch disk 118
configuring, storing cache files 118
issues with DV 128
issues with render files 129
migrating media to EditShare 123, 125
organizing captured media files from 50
organizing projects 121
preparing to migrate media to EditShare 122
rendering to wrong drive 129
saving settings 119
shared projects workflow 15
sharing project data using XML files 126
sharing projects 120
strategies for reliable output 129
using DAVE to share projects 121

Functions
of Limited Administrator 73

G
Green lock icon 48, 98
Group Bins folder 62

H
Hardware 11

I
Individual projects workflow 16
Instant messenging

creating Jabber account 137
installing Jabber 137
with Jabber 137
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J
Jabber Instant Messenger

communicating with 137
creating account on 137
installing 137

L
Launching Avid from EditShare Connect 102
Leopard

preparing workstations 22
Scratch disks on 118

Limited Administrator
by capability 72
by Media Space 71
described 71
functions of 73

Linux OS 11
Locations

of Premiere Pro files 131
Lock icons

in Avid bin 48, 98
in Avid bins 59, 98, 105

Logging into EditShare Connect 25
Logging out of EditShare Connect 34
Login count

resetting 27

M
Macintosh workstation

using DAVE for Avid 86
Maintenance mode

in AvidMXF Media Space 46
in Managed Media Space 52

Managed Media Spaces
controlling files in 50
deleting media in 52
described 48
protecting media in 51

Managing Spaces 33
Mandriva Linux OS 11
Matrox card

capturing with in Premiere Pro 132
Media database files (Avid)

copying another user’s 110
described 106
when to copy 109

Media database files (Avid) and AvidMXF Media Spaces 107
Media database files (Avid) and Traditional Media Spaces 107
Media files

Avid, managing names of 151
Avid, storing large numbers in Media Space 90

described 17
managing Avid 90
migrating existing to EditShare 34
organizing by tape or subject 50

Media Space
described 12

Media Spaces
AvidMXF 39
AvidMXF and media database files 107
AvidMXF, making QuickTime movies in 41
Avid-Style, described 48, 98
Avid-Style, sharing projects in 59, 98, 105
Avid-Style, using Avid Launcher with 102
controlling access to 38
disconnecting or unmounting 33
limited administration of 71
limiting large number of Avid files in 90
Managed 48
managing 33
Miscellaneous folder in 143
mounting 28
mounting automatically 31
protecting media in 38
selecting in Avid Capture tool 90
Traditional and Avid media database files 107
Traditional OtherNLE 135
Traditional OtherNLE, capturing in Liquid 135
Traditional, about automatically Sharing and Refreshing 

files 147
Traditional, automatically Sharing and Refreshing files 

manually 149
Traditional, modifying files in 144
Traditional, Sharing and Refreshing files in 145
Traditional, sharing and refreshing files manually 146
types of 39
Unmanaged 53
updating 32
using multiple 37
using Traditional with Premiere Pro 131, 151

Metadata files
Avid, locations of 91
described 18
sharing in Premiere Pro 133

Metadata Spaces
Avid Shared Project, creating new 58
Avid Shared Project, described 57
File Exchange, described 56
Final Cut Shared Project, described 59
Private Files, described 55
Shared Project browsing 64
Shared Project browsing with pop-out browser 68
Shared Project structure 62
Shared Project, described 60

Migrating
Avid media and projects, preparing to 111



Index  A B C D E F G H I J K L M N O P Q R S T U V W X Y Z

158

Avid media using Consolidate 112
Avid media using Relink 114
Avid project files 115, 125
existing media and projects to EditShare 34
Final Cut Pro media by reconnecting 125
Final Cut Pro media using Media Manager 123
Final Cut Pro media, preparing to 122

Miscellaneous folder
in Traditional Media Spaces 143

Mounting Media Spaces
automatically 31
manually 28

Movies, QuickTime
making with QuickTime Reference mode 42
making with special-purpose usernames 42

N
Names

folder, restrictions on 62
Network Attached Storage server 11
Network performance 118

get best for Final Cut Pro 117
Network storage

connecting to with DAVE 86
Networked drives

disabling Avid filter 77
enabling Avid to see 76
enabling Avid to see using alldrives 76
enabling Avid to see using Avid Launcher 102
mapping Media Spaces as in Premiere Pro 132

Non-alphanumeric characters with Avid 87
Non-Avid projects

creating in Project Browser 66

O
OMF files and Traditional Media Spaces 107
Organizing media

in AvidMXF Space 46
OS X

preparing workstations 22
Other files

described 18
Other Users folder 62

P
Password

changing in EditShare Connect 27
Pop-out Project Browser 68
Premiere Pro

capturing DV footage 132
file locations 131

mapping Media Spaces as networked drives 132
naming clips during capture 153
setting up Scratch disks 152
sharing metadata with other users 133
using Traditional Media Spaces with 131, 151

Private Files Spaces
described 12, 55

Project Browser
creating new projects in 66

Project files
sharing 18

Project Space
described 12

Project Spaces
multiple Shared 69

Projects
creating new in Project Browser 66
deleting Shared Avid 93
migrating existing to EditShare 34
organizing in Final Cut Pro 121
Shared Project Files Space 93
shared, adding titles to 93
sharing Avid 92
sharing Avid, settings for 93
sharing Final Cut Pro 120
sharing in Avid-Style Media Spaces 59, 98, 105
sharing in Final Cut Pro with XML 126

Protecting media 38
in AvidMXF Space 45

Protecting media in Managed Media Spaces 51
Public Media Spaces 39

Q
QuickTime movies

making using QuickTime Reference mode 42
making using special-purpose usernames 42

QuickTime Reference mode 41
leaving 43
making QuickTime movies with 42

QuickTime reference movie
making QuickTime movies with 41

Quota
on Media Spaces 37

R
Read/write access

to Media Spaces 38
Red lock icon 48, 98
Reliable output in Final Cut Pro 129
Render files

issues in Final Cut Pro 129
on wrong drive in Final Cut Pro 129
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Restrictions
on folder names 62

Root folder 62

S
Scratch disk

selecting on Leopard 118
setting up for Premiere Pro 152

Servers
NAS 11
networked 11

Settings
saving Final Cut Pro 119

Shared Project Space
described 12
selecting to save Avid project to 89

Shared Project Spaces
Avid, creating new 58
Avid, working with 57
described 60
Final Cut, described 59
folders in 62
viewing with pop-out Project browser 68
viewing with Project browser 64
working from multiple 69

Shared Projects
adding titles to 93

Shared projects workflow
Avid 15
FCP 15

Sharing
metadata files vs media files 18
metadata in Premiere Pro 133

Sharing and Refreshing files
automatically in Traditional Media Spaces 149
by Administrator 149
in Traditional Media Spaces 145, 147
in Traditional Media Spaces, manually 146

Sharing projects
Avid 92
Avid bins 93
Avid projects, deleting 93
selecting Avid settings 93

Simple file sharing
disabling in Windows XP 79

Snow Leopard
preparing workstations 22

Software
upgrading Avid 87

Spaces
Avid Shared Project (metadata) 57
Avid Shared Project (metadata), creating new 58
AvidMXF 39

AvidMXF, making QuickTime movies in 41
connecting to with EditShare Connect 28
controlling access to 38
controlling files in Managed 50
deleting media in Managed 52
described 12
disconnecting or unmounting 33
File Exchange (metadata), described 56
Final Cut Shared Project (metadata), described 59
Managed 48
managing 33
Private Files (metadata), described 55
protecting media in 38
protecting media in Managed 51
Shared Project (metadata) pop-out Project browser 68
Shared Project (metadata) Project browser 64
Shared Project (metadata) structure 62
Shared Project (metadata), described 60
Traditional 141
Traditional, about automatically Sharing and Refreshing 

files 147
Traditional, automatically Sharing and Refreshing files 149
Traditional, Miscellaneous folder in 143
Traditional, modifying files in 144
Traditional, sharing and refreshing files manually 146
Traditional, Sharing and Refreshing in 145
types of 39
Unmanaged 53
updating 32
using multiple 37

System, described 11

T
Technical Support 10
Thumbnail cache files (Final Cut Pro) 118
Titles

adding to Shared Project 93
Top-level folder 62
Tracking file control in Managed Media Spaces 50
Traditional Media Spaces 141

about automatically Sharing and Refreshing 147
Administrator Sharing and Refreshing 149
automatically Sharing and Refreshing 149
deleting and organizing files by Unsharing 150
described 141
Miscellaneous folder 143
modifying files in 144
Sharing and Refreshing files in 145
sharing and refreshing files manually 146
using with Premiere Pro 131, 151

Traditional Other NLE Media Spaces
capture locations in 135
capturing DV video in Avid Liquid Edition 135
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Traditional workflow 17
Troubleshooting EditShare Connect 35

U
Unmanaged Media Spaces

described 53
Unmounting Spaces 33
Unprotected Bins folder 62
Unprotected Projects folder 62
Unsharing files

in Traditional Media Spaces 150
User folders

described 62
hiding 44
hiding to deal with corrupted media 45

Usernames
making QuickTime movies with 42

V
Vista

disabling file sharing in 80, 82

W
Waveform cache files (Final Cut Pro) 118
Windows Vista

disabling simple file sharing in 80, 82
Windows workstation

disabling simple file sharing for Avid 78
Windows XP

disabling simple file sharing in 79
Windows-compatible names

using with Avid 87
Workflow

Avid editors shared projects 15
Final Cut Pro editors shared projects 15
individual projects 16
traditional 17

Workstations
configuring for Avid 75
connecting to with EditShare Connect 25
setting up for OS X 22
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